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Getting Started with General Operations 

Within our documentation, some content might be specific for cloud deployments while other 
content is relevant for on-premises deployments. Any content that applies to only one of these 
deployments is labeled accordingly. 

Primavera Unifier is a project lifecycle management solution for capital planning, project delivery, 
cost control, and facilities and real estate management. Unifier provides governance across all 
project phases, from planning and building to operations and maintenance. 

Primavera Unifier has two modes of operation. 

 User mode

Users spend most of their time in the User mode. The User mode allows users perform the 
day-to-day activities, collaborate through business processes and Mailbox, maintain, for 
example, the Cost Manager, Schedule Manager, and Document Manager, and run reports. 

The Unifier User Guide explains how to use the options that are available in the user mode of 
operation. 

 Admin (Administration) mode

Company administrators work in Admin mode to set up, for example, company, program, 
and project or shell properties, user permissions, templates for major Unifier features, data 
structures, and configure and set up business process (BP) workflows. 

You can switch between modes using the mode icon. 

Note: This option is not available in Home page because Home page 
does not support the Admin mode. 

Access to Unifier functionality is granted through Permissions. The ability to utilize a specific 
function in Unifier depends on permissions settings (accessed in Admin mode). 

The Unifier user guides are: 

 Unifier General User Guide 

 Unifier Programs, Shells, and Projects User Guide 

 Unifier Business Processes User Guide 

 Unifier Managers User Guide 

Each user guide explains how to use specific parts of the Unifier application. 

The following explains how to work with Unifier: 

 Consent notices 

 Cookies policy 

 Information for the first time users 

 System configuration 

 Browsers and settings 

 User interface 

 Sign in 
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 Self-service portal 

 Security 

 File viewer 

 Modes of operation 

 Navigation 

 Modules overview 

 Common procedures 

 P6, Unifier, and Gateway 

 Reports 

 Mobile device 

In This Section 

About Consent Notices (Users) ................................................................................. 8 
Cookies Policy ........................................................................................................... 9 
Information for First Time Users .............................................................................. 11 
Configuring Your System for Unifier ......................................................................... 13 
Supported Browsers and Settings ........................................................................... 15 
User Interface (UI) Content and Internationalization ................................................ 17 
Navigating Using a Keyboard .................................................................................. 19 
User Name and Password ....................................................................................... 23 
Sign In, Sign Out, and Session Timeout .................................................................. 25 
Signing In to Self-Service Portal .............................................................................. 27 
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Company Landing Page (User) ............................................................................... 58 
Shell Landing Page (User) - Details ......................................................................... 60 
Dashboard and Tabs ............................................................................................... 65 
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Home Page ............................................................................................................. 69 
Unifier User Mode .................................................................................................... 75 
Unifier Modules Overview ........................................................................................ 77 
Common Procedures ............................................................................................... 79 
P6, Unifier, and Gateway ....................................................................................... 125 
Unifier Reports....................................................................................................... 131 
Unifier Mobile Application for iOS or Android ......................................................... 157 

About Consent Notices (Users) 

Consent notices alert you to the need to protect personal information (PI). You and your 
organization might be collecting, processing, storing, and transmitting PI while using Unifier. 
When you accept a consent notice, your consent covers the collection, processing, storing, and 
transmission of PI data in all areas of Unifier and means of retrieving data from Unifier including 
but not limited to project export, downloaded tables, reports, documents, web services, API, and 
Unifier. If you refuse consent you might not be able to access some areas of Unifier. 
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You may be asked to provide consent to show that you understand the need to treat PI as 
secure data. You may also be asked to provide consent for your organization to collect, process, 
store, and transmit your PI. If you refuse consent you will be denied access to Unifier. 

Cookies Policy 

Oracle might use cookies for authentication, session management, remembering application 
behavior preferences and performance characteristics, and to provide documentation support. 

Also, Oracle might use cookies to remember your log-in details, collect statistics to optimize site 
functionality, and deliver marketing based on your interests.  

When using Unifier, the server may generate cookies and send them to the user’s browser. The 
user’s machine stores the cookies, either temporarily by the browser, or permanently until they 
expire or are removed manually.  

Each user that signs in to Unifier web will see a notification banner (Cookies in Unifier) that 
notifies the user that Unifier uses cookies. This banner has a link to the Unifier cookie policy 
which explains what information is being tracked by way of cookies. The user must click Got It in 
order to access the rest of the Unifier application.  

Oracle might use cookies for authentication, session management, remembering application 
behavior preferences and performance characteristics, and to provide documentation support. 
Also, Oracle might use cookies to remember your log-in details, collect statistics to optimize site 
functionality, and deliver marketing based on your interests.  

For more information on Oracle's data collection processes and privacy commitments, see:  

Oracle Cloud Services Agreement

http://www.oracle.com/us/corporate/contracts/saas-online-csa-us-1894130.pdf 

Oracle Privacy Policy

https://www.oracle.com/legal/privacy/services-privacy-policy.html 

Oracle Data Processing Agreement

https://www.oracle.com/corporate/contracts/cloud-services/ 
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Information for First Time Users 

You need to have Administrator privileges, on the local machine, before you can configure your 
computer for use with Primavera Unifier and install certain plug-ins. Always review this 
information with your IT department. 

Before using Unifier with Internet Explorer (IE), ensure that the security settings for the Internet 
zone is set as Medium or Medium-High. 
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Configuring Your System for Unifier 

Ensure that the necessary browser settings (within the supported browsers) are configured for 
the computers that access Unifier. For the full list of system requirements and versions refer to 
the Unifier Tested Configurations spreadsheet. 
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Supported Browsers and Settings 

You can use Primavera Unifier with the following supported browsers: 

 Microsoft Edge

 Microsoft Internet Explorer

 Mozilla Firefox

 Google Chrome

 Apple Safari

Notes: 

 For the full list of system requirements, supported software, and 
versions, refer to the Tested Configurations document. 

 For additional information about plug-ins, go to: 
https://www.java.com/en/download/help/enable_browser.xml, or 
https://www.java.com/en/download/faq/chrome.xml. 

Microsoft Edge 

Refer to Microsoft Edge Help to see the details on language settings and how to set up the 
options explained here.  

Microsoft Internet Explorer (IE) 

Refer to Microsoft Internet Explorer Help to see the details on language settings and how to set 
up the options explained here.  

To configure the IE browser for Unifier ensure that the security settings for the Internet zone is 
set as Medium or Medium-High. If your internet settings are customized, contact your IT for 
more information. When finished, sign out of Unifier and close the browser completely in order 
for the new settings to take effect. 

For plug-ins, follow these steps: 

Note: Depending on your IE setup, these instructions may vary. 

1) Click Tools and then Internet Options. 

2) Select the Security tab and select the Custom Level. 

3) Scroll down to Scripting of Java applets. 

4) Ensure that the Enable radio button is checked. 

5) Click OK to save your preference. 

Mozilla Firefox 

Refer to Mozilla Firefox Help to see the details on language settings. If your internet settings are 
customized, contact your IT for more information. When finished, sign out of Unifier and close 
the browser completely in order for the new settings to take effect. 

For plug-ins, follow these steps: 
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1) Open the Firefox browser, or restart it if it is already running. 

2) From the Firefox Menu Bar, select Tools, then click Add-ons. 

3) In the Add-ons Manager window, select Plugins. 

4) Click to select the Java (TM) Platform plug-in (Windows), or the Java Applet Plug-in (Mac 
OS X). 

5) Ensure that the option "Ask to Activate" or "Always Activate" is selected. For older 
versions of Firefox, click Enable. Note that if the button displays Disable, Java is already 
enabled. 

Google Chrome 

Refer to Google Chrome Help to see the details on language settings. If your internet settings 
are customized, contact your IT for more information. When finished, sign out of Unifier and 
close the browser completely in order for the new settings to take effect. 

Note: AutoVue viewing is not supported in Google Chrome. 

Apple Safari 

Refer to Safari Help to see the details on how to set up the options explained here. 

To use Apple Safari you must set Java to Run in Unsafe Mode, in browser preferences. Go to 
Preferences, under Security select Java, then select Run in Unsafe Mode, and click OK. 

For plug-ins, follow these steps: 

1) Click on Safari and select Preferences. 

2) Select the Security option. 

3) Select Allow Plug-ins, then click on Manage Website Settings. 

4) Click on the Java item, select one of the options: Ask, Allow, or Allow Always (from the 
drop-down list When visiting other websites). 

5) Click Done and close the Safari Preferences window.  
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User Interface (UI) Content and Internationalization 

The contents that appear in the Unifier application UI (also known as System Strings) cannot be 
modified by the Users. The System Strings are available in different languages, per user 
preferences. 

Example 

Sign In and Terms and Condition pages, Menus, Alerts, and Errors 

In contrast, the content of the material created by the Users (also known as Custom Strings) can 
be translated into different languages. Refer to the "Translating Custom Strings 
(Internationalization)" section of the Unifier Administration Guide, for details. 

Example 

Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text 
in lines, navigation log names, and multi select values 

Notes:  

 The user input data (data entry) in Business Processes (BPs), 
attribute forms of various managers (Cost Manager, Document 
Manager, etc.), and other similar elements, when entered at runtime, 
cannot be translated. 

 User’s data entry must be saved “as-is” and include support for single 
and multi-byte characters UCS Transformation Format—8-bit 
(UTF-8).  

For more information see "Internationalization" section, also. 
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Navigating Using a Keyboard 

You can use your computer keyboard to navigate throughout the Unifier application. Use the 
Tab key to cycle through elements within the application and press Enter to access them. Use 
the application keyboard shortcuts to access frequently used or important functionality. 

Note: The keyboard shortcuts may change depending on the browser 
you use. 

Main Content Area 

Use Ctrl + + or - to zoom in and zoom out anywhere in the application. 

Use Tab key to highlight the toolbar buttons and press Enter to make the action applicable. 

Grids

A grid contains content rendered in a tabular format. Any grid has a similar method of 
interaction. Grids are extensively used in places such as the logs (ex: Business Process Record 
log, Line Item list, Document Manager log, Cost Manager log, Mailbox etc.), Sheets (ex: Cost 
Sheet, Funding Sheet, Cash Flow worksheet, Activity Sheet, Portfolio Manager Sheet etc.) 

Only the rows that are visible are rendered. As you navigate up and down the table more items 
will be visible. 

To enter the table, tab to it. Tabbing to the table will cause an overlay to be displayed with the 
message Press tab to skip over this widget. Press Enter, Esc or click to enter the grid. 

Use Arrows or Tab and Shift + Tab to navigate through the table. To move focus to another cell 
when you reach the end of the row, use the Arrows or Shift + Tab. 

Editable Grid

Any grid that has editable content has a similar method of interaction. Examples of such grids 
are the Line item grids seen in business processes, manual entry columns in Cost Sheet and so 
forth. 

Press F2 or Enter to put the cell in edit mode. 

To select a value from a list of values from fields of type Pull Down, navigate to the cell by 
tabbing, and press F2 or Enter. Use Up and Down Arrows to highlight an option. Press Enter to 
select the option. 

To select a value from a calendar picker from fields of type Date and Date Only Pickers, 
navigate to the cell by tabbing, and press F2 or Enter. Use the Tab key to change the Month and 
Year selection and use the Up and Down Arrows to highlight an option. Press Enter to select the 
option. 

Individual Web Elements 

Hyperlink Fields

Tab to enter into the Hyperlink field. 

Press Enter to view the Hyperlink field attributes. 



Unifier General User Guide

20

Tab to the Name field and enter your choice. 

Tab to the URL field and type in the URL. 

Tab to access the Clear, Cancel, or Done options. 

Press Enter to select choice and close the hyperlink field 

Pull-Down 

Tab into the cell. 

Press Enter. 

Use Up and Down Arrows to highlight the option. 

Alternatively, type the value. 

Press Enter to select the option. 

Picker

Tab into the cell. 

Press Enter. 

Type a value for the Display Element. 

Press Up and Down Arrows to highlight choice. 

Press Enter to select choice and close picker. 

Multi Select Input fields

Option 1: 

1. Tab into the cell 

2. Press Up and Down Arrows to highlight choice 

3. Select your choice. 

4. Press Enter to select 

Option 2: 

1. Tab into the cell 

2. Type a value 

3. Press Up and Down Arrows to highlight choice 

4. Press Enter to select. 

Date Picker fields

Option 1: 

1. Tab into the cell 

2. Type the date in the format specified 

3. Press Enter  

4. Tab out of the cell 

Option 2: 

1. Tab into the cell 
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2. Use the Up, Down, Left, and Right arrows to select a value 

3. Tab to select the Action button 

4. Press Enter 

Number Fields

1. Tab into the cell 

2. Enter the value 

3. Tab out of the cell 

4. Text Fields 

5. Tab into the cell 

6. Enter the string 

7. Tab out of the cell 

Using Shortcut Keys 

The following tables list the menu options that have shortcut keys. If an option is not listed, it 
does not have a shortcut key. 

Function Keys Supported in Unifier

Command Function Key 

Reload / Refresh F5 

Close browser windows Alt + F4 

Hot keys Supported in the Editable Grid of Unifier

Command Hot Key 

Select All Ctrl A 

Cut Ctrl X 

Copy Ctrl C 

Paste Ctrl V 

Undo Ctrl Z 

Redo Ctrl Y 
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User Name and Password 

Before you can sign in to Primavera Unifier, you must have a user account, which will provide 
you with a Login Username and a Password that you can use to sign in to the Primavera Unifier 
system. Your Primavera Unifier Company Administrator(s) should be able to create your user 
account and provide you with your Login Username and Password.  

Note: If Oracle Primavera Customer Support Team is administering the 
setup and user administration for your company, you will receive your 
Login Username and Password directly from them. 

Sign in for the First Time 

To sign in to the Unifier for the first time:  

1) Enter username and password. 

2) Click Sign In. 

3) Click Accept in the Consent Agreement. 

The Password Recovery secret questions setup form is displayed. 

To setup the security questions, if the system redirects you to the security setup form: 

Note: You would see a blurred background of the last instance before 
logging off if you logged in earlier but did not setup the security 
questions. 

1) In the password recovery form, select the questions and enter the answers to the mandatory 
fields. 

2) Click Save to save the entered values. 

3) Click Done to exit the form. You are brought back to the instance that you were in before 
logging off. 

4) Alternatively, click Sign out to exit the form if you do not want to setup the security 
questions. 

To find if the company policy makes it mandatory for you to setup the password recovery secret 
questions: 

1) Click the user control panel on the top right. 

2) Click Preferences. 

3) Click Security. 

The password recovery secret questions are marked as required fields with the selected 
questions and the answers provided at the time of login. 
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Note: The answers are masked. 

Forgot Password (on-premises only)  

You can reset your own password by answering security questions, if this option is made 
available to you by the Administrator. 

Note: Enabling the user to use security questions to reset password 
must be done by the Administrator at the company level. Oracle 
recommends that the Administrators set up security questions so users 
can reset their own passwords. 

If the option to use security questions to reset password has been made available, then Unifier 
directs you to the setup page to enter your security questions and proceed with changing your 
password. 

If the option to use security questions to reset password has not been made available, then 
Unifier does not direct you to the setup page. In this case, you must contact your Administrator 
to request password reset. 

To reset your password: 

1) In the Primavera Unifier Sign In window, click Forgot Password. 

2) Enter your user name and email address, and click OK. 

3) Answer your Secret Question(s) and click Submit. You will receive an email notification 
containing your reset password. Use the new password to sign in to Primavera Unifier. 

To add secret questions to use when resetting your password: 

1) Sign in to Primavera Unifier, then click the Preferences link in the upper right portion of the 
Primavera Unifier window. 

2) Click the Security tab. 

3) Under Password Recovery Secret Questions, select a question and enter the answer. You 
can add up to three Secret Questions. 
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Sign In, Sign Out, and Session Timeout 

Sign In and Sign Out 

To access the Primavera Unifier Sign In window follow these steps:  

Notes:  

 The Sign In page appears based on the supported browser language. 
If the browser is not supported, the Sign In page appears in English. 

 After signing in to Unifier, the Unifier language will be based on the 
Language selected in the Preferences. See Preferences (on page 
40) section for details. 

1) Open your browser and enter the web address that your site administrator has provided for 
you. 

2) Enter your user name. 

3) Enter the password that was set for you during the Unifier installation. 

4) Click Sign In to open the application. 

To sign out of the Primavera Unifier:  

1) Click your user name to open a contextual menu. 

2) Click Sign Out from the upper right-corner of the Unifier window. 

If you have trouble signing in, check to ensure that: 

 The Caps Lock function is not on (user names and passwords are case-sensitive). 

 You entered the correct user name and password. 

If you still have trouble signing in, contact your Company Administrator or Oracle Customer 
Support. 

After signing in for the first time, you may wish, or be required, to change your password. 

Note: Save your work often.  

Session Timeout 

Unifier displays a warning after five minutes of inactivity: Session Inactive. 

 If you click Stay Signed In, then your session will remain active. This applies to Unifier 
sessions running in other browser tabs. 

 If you do not respond, or if you are inactive for more than five minutes, then Unifier will 
terminate your session and displays an alert: Your login session may have expired due to 
inactivity. 

When your session expires, the system redirects you to the sign in page if there are no active 
Unifier session running, or there are inactive Unifier sessions, in other browser tabs. 
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Signing In to Self-Service Portal 

Portal Users  

Portal users can access the Unifier website and Portal website. Once the Portal user logs in, the 
Portal landing page is displayed. 

Self-Service Portal 

Certain business processes can be enabled for access through the Self-Service Portal. The 
actions users can take through the Self-Service Portal are: 

 Create a business process 

 Modify a business process 

 Add or remove business process attachments 

 Add General Comments to a business process 

Sign in to the Self-Service Portal 

To sign into the Self-Service Portal Landing Page:  

1) In your web browser, enter the URL you use to access Primavera Unifier, followed by /portal. 
For example: https://your-web-address.com/portal

2) Enter your Self-Service Portal user name and password. 

3) Click the Sign In. The landing Page opens. 

Note: You must have the proper permissions to use the options 
indicated below. 

Self-Service Portal Navigation  

The Portal has a fixed Home tab along with Portal Business Processes (BPs) tabs. 

 You can re-sequence the tabs through drag-and-drop. 

 Unifier retains the last saved tab sequence. 

 You cannot close the tabs. 

To open or edit an existing record: 

1) Click the business process tab. The business process log opens in the right-hand pane, 
listing all available records that you have permission to view. 

2) Select the record from the log and click Open (or double-click the record from the log.) The 
record opens in the view-only mode. 

3) To edit the details, click the Edit button. 

4) Make necessary edits to the form. 

5) Click Submit to submit the edited record. 
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Note: You must have the proper permissions to create, view, or edit 
portal-enabled records. 

Self-Service Portal Home Page (Landing Page) 

If your administrator has setup an active (Home) landing page, then the active (Home) landing 
page is displayed. If your administrator did not setup an active (Home) landing page, then a 
system-provided Home landing page is displayed. The system-provided Home landing page has 
the following attributes: 

 This page contains pie-charts for each of the BPs. 

 The pie-chart has status-based colors corresponding to the status of the BP. 

 If there are no records for a given portal BP, then an informational text is displayed. Under 
each pie-chart a grid is displayed that contains the Record Number, Title, and Status 
information. 

 Only the top five records are displayed, in descending order, based on the last updated date. 

 You cannot open the record from the grid. When you click the pie-chart, Unifier opens the 
respective BP tab. 

Note: All the Portal enabled BPs will get a tile on the Portal landing 
page, based on user permission. If there are more than 3 BPs, then 
Unifier displays a scroll-bar for viewing more tiles. The order of tiles is 
determined by the most recently updated BP records. 

Self-Service Portal Business Processes Log Page (Master Log - Business Processes 
Node) 

The log page enables you to see the records and conduct the following:  

 Create: To create new records. 

 Actions: To select the following options for bulk selection of records: 

 Bulk Edit: This option is displayed if you have the permission. 

 Print: Provides user the ability to print multiple records as per the selected format 
(HTML, PDF, and Custom) 

 Transfer Ownership: Transferring the ownership to another user. This option is available 
if you have the "Modify Ownership" permission. 

 Terminate Record: Terminating a record. This option is available if you have the 
"Terminate Workflow" permission. 

 View: To see the views that have been defined in Business Process Configuration. For 
example: All Records, Records Created by Me, Create New View, and Manage Views. 

 Edit View ( ): To edit the view settings. 

 Refresh ( ): To refresh the items on the page. 

 Print: To print the log content, Export to CSV, or Export to Excel. 

 Search ( ): To open the Search window and search the log based on pre-defined 
uDesigner search fields. 
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 Find Page ( ): To conduct a search within the displayed page content. 

 Help ( ): To view help options. 

The gear ( ) menu, displayed in front of each record when hovering over the record, enables 
you to: 

 Open: To open a record. 

 Copy with Attachments: To copy a record. 

 Copy without Attachments: To copy a record. 

 Print - HTML: To print a record. 

 Print - PDF: To print a record. 

 Print - Custom: To print a record. 

 Transfer Ownership: To transfer the record ownership to another user. This option is 
available when the user has "Modify Ownership" permission, only. 

 Terminate Record: To terminate a record. This option is available when the user has 
"Terminate Workflow" permission, only. 

When you select a record, the log page displays a pane on the right-hand side of the page. Use 
this pane to see the record details and attachments by using the following tabs: 

 Record Details

 Attachments

Self-Service Portal: Creating and Submitting a New Record (Existing Users Only) 

1) Select a business process to work with from the log in the left Navigator.  

2) Click New. 

Note: The New option displays if this element is designed in Unifier 
Configuration. If not, you need to click Create, as explained below. 

3) Fill out the business process form. 

4) Click Submit. 

Self-Service Portal: Preferences (User Preference) 

The Preferences window enables you to enter specific information by using the following tabs:  

 General

The Personal Information contains the First Name and Last Name fields, only. 

 Security

Some of the options are not available for cloud customers. 

 Email Subscription

This option is not available in Self-Service Portal. 

 Region Format

 Proxy

This option is not available in Self-Service Portal. 
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 More

See Preferences (on page 40) for additional details about the Preferences window. 
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Security Warnings 

The first time you perform certain functions in Primavera Unifier, security warnings may appear 
from third party software confirming the use of Java plug-ins from these business partners. 

Follow the instructions below to prevent the warnings from recurring every time that you use the 
functionality in Primavera Unifier that requires these certificates. 

Preventing a Security Warning from Recurring 

A first time user may receive a security warning. When prompted by your browser to 
acknowledge a security warning in Unifier, you may select your browser option to ignore future 
warnings. The setting to ignore warnings varies by browser. 
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File Viewer Option 

The following topics discuss the basic user preferences settings that should be configured 
before using Unifier for the first time. 

For more information regarding all Preferences settings, see Unifier Help or Unifier User Guide. 

File Viewer Option (Select Default Viewer) 

Primavera Unifier provides two methods of viewing files: 

 Native 

 Unifier Viewer 

Unifier Viewer is the default option. The Viewer lets you view and markup documents. The 
markups are saved as markups without changing the original file. Native Viewer allows you to 
view most file formats in the application in which you created or regularly view them. In other 
words, if you view a .doc file in Native, Microsoft Word will open and display the .doc file. 
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Unifier Interface 

The Unifier interface consists of the following parts:  

1) Top pane (first row) 

2) Top pane (second row) 

3) Navigator (left-hand pane) 

4) Log (right-had pane) 

The following explains each part in details. 

In This Section 

Unifier Interface (Top Pane-First Row) .................................................................... 35 
Unifier Interface (Top Pane-Second Row) ............................................................... 36 
Unifier Interface (Navigator) .................................................................................... 37 
Unifier Interface (Log) .............................................................................................. 38 
View Help Menu ...................................................................................................... 38 
User Control Panel .................................................................................................. 40 

Unifier Interface (Top Pane-First Row) 

The top pane (first row) contains the following elements: 

 Unifier logo (Oracle Primavera Unifier) 

 New User Interface ( ) or Disable New User Interface ( ) 

To view the redesigned user interface when viewing BP record forms. This option is available 
in Staging and Test environments. Only simple and line item BPs are rendered in the new 
user interface. 

 Announcements (the megaphone icon ) 

To view announcements. It is sorted by creation date (Latest at the top). Refer to the Unifier 
Administration Guide for more details.  

When a new announcement record is unread, a red bubble count-indicator icon appears on 
top of the grey announcement icon (the megaphone icon). In the bubble icon, the number of 
unread announcements is displayed. 

When there are no unread announcements, the bubble count-indicator disappears. 

When you click the announcement icon (the megaphone icon), a grid appears that displays 
all of the unread announcements, highlighted in red. All the announcements are displayed in 
descending order, according to the date. 

Once an announcement record has been read by a user, the title of the record is displayed in 
black. When you click the announcement hyperlink, the announcement grid appears. 

In the announcement grid, the active (Status = Active) announcement records are 
displayed, only. The Title, Last Modified By, and Last Modified Date (for both company 
and system announcements) fields are also displayed. 
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For the system announcements created by the Site Administrator, the sign-in name of the 
Site Administrator is displayed in the Last Modified By field. 

For company announcements, the full name (First + Last Name) of the user who created 
(Last Modified By) the record, is displayed in the Last Modified By field. 

 Bookmarks ( ) 

To bookmark a page. 

 View Help Menu (on page 38) ( ) 

Enables you to access the following: 

 Unifier Help

 Unifier Library

 Contact Support

 Download Plugins

 About Unifier

 User Control Panel (on page 40) ( ) 

Displays the name of the person who has signed in. If you click the down-arrow, you can 
access the following features:  

 Get Unifier Mobile App

Enables you to open a new window and proceed to download the Unifier Mobile App. 

 Preferences

Enables you to access the Preferences window. See Preferences (on page 40). 

 Change Password

Enables you to open the Change Password window. 

 Last login

Provides the date and time of last log in. 

 Sign Out

Enables you to sign out of Unifier. 

Unifier Interface (Top Pane-Second Row) 

The top pane (second row) contains the following elements: 

 Dashboard icon (  ) 

If you have permission, you will see this icon and can use it to see the dashboard. 

 Home icon ( ) 

To go to the Home page and access the following nodes: 

 Tasks

 Notifications

 Drafts

 Mailbox

 Master Log - Business Processes
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 Company, Shells, and Projects tabs 

Note: Based on the display option chosen in the Company Properties 
(Admin mode), either the name or the number of the shells or projects 
will be displayed on the tab.   

 New tab icon ( ) 

To add a new tab.The location launcher drop-down displays three sections – Recent 
Locations (recently accessed locations), Bookmarks (locations you have saved in 
Bookmarks), and Key Locations (Company Workspace and single-instance shells). The 
height of the initial drop-down dynamically varies based on the number of items in Key 
Locations. Use the type ahead text field to quickly find a location. Alternatively, click the shell 
picker icon in the text field to use the shell picker instead.  

 Switch to tab icon ( ) 

Unifier Interface (Navigator) 

The left-hand pane houses the Navigator. You can use the Navigator to access Unifier features 
within a company, a project, and a shell. 

You (Company administrator) can configure the User mode Navigator (Company Workspace > 
Admin mode > Configuration > User Mode Navigator) to better suit the company business 
needs. 

Example 

Creating additional nodes to store business process records, renaming nodes, and so on. 

Note: Your Navigator setup may differ, but the basic functionality will be 
the same. 

Every module, feature, and record in Unifier can be accessed by way of the Navigator, which is 
always available in the left-hand pane of the Unifier screen. The Navigator is similar to a folder 
system, much like a network drive. Each feature is stored in its own "node," similar to a folder. 
Each node is controlled by permissions. If you do not see a feature in the Navigator, contact 
your project or shell Administrator or Company Administrator to verify that you have been 
assigned the proper access permissions. 

As you access different nodes (modules) on the left-hand Navigator, the Navigator remains 
available on the left of the screen, while the content frame on the right changes. 

Use the Expand (+) all or Collapse all (-) icons ( ) at the bottom of the Navigator pane to 
expand or collapse all the nodes (modules) in the Navigator. 

The right-hand pane houses the logs. Additional functions are available from the options and 
links at various parts of the logs. 
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Unifier Interface (Log) 

The Unifier log is the pane next to the Navigator. On top, below the company, shell, and project 
tabs, the locator links (breadcrumbs) are displayed. The locator links: 

 Enable you to follow the path to the current location 

 Always include home 

You can click the home drop-down arrow to display key locations. 

Click the home link (for example All Projects) to go to the Home landing page. 

Click the drop-down arrow of a locator link (breadcrumb) to reveal the direct children or 
sub-shells of that location. 

Even if you do not have permission to access a shell, the shell name appears in the breadcrumb 
trail. 

In front of the breadcrumbs, the user mode icon ( ) appears. 

Note: The Admin mode option is not available for Home page . 

View Help Menu 

The following is a list of additional support available through Unifier View Help Menu (the 

question mark icon: ):  

 Unifier Help (on page 38) 

 Unifier Library (on page 38) 

 Contact Support (on page 39) 

 Download Plugins (on page 39) 

 About Unifier (on page 40) 

Unifier Help 

Click View Help Menu (the question mark icon: ) from the upper right-hand section of the 
Unifier window to open a contextual menu and click Unifier Help to access the Unifier Help and 
uDesigner Help. 

Unifier Library 

Click View Help Menu (the question mark icon: ) from the upper right-hand section of the 
Unifier window to open a contextual menu and click Unifier Library. 
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Contact Support 

Click View Help Menu (the question mark icon: ) from the upper right-hand section of the 
Unifier window to open a contextual menu and click Contact Support to open the Support 
window. 

The Support window has two tabs: 

 Contact (opens by default) 

 Download

In the Contact tab, Contact Information section, you can see the name, phone, and contact 
instructions of someone at your company that you can contact when you need help with 
Primavera Unifier. For assistance, try this person, first. 

Note: This information is available only if your company administrator 
has provided internal support contact information. 

In the Contact tab, eLearning section, you see the location (Access), name of the contact 
(Contact), and any instructions that you might need in order to access the eLearning materials. 

Note: Your company may elect to provide access to the eLearning suite, 
where you can access interactive Primavera Unifier learning materials. 
Alternatively, your company may have its own customized support or 
training materials that can be accessed on an internal site/location. If 
your company administrator provides this contact information, it will be 
listed at the bottom of the window. 

For information about the Download tab, read the following topic: Download Plugins. 

Download Plugins 

Click View Help Menu (the question mark icon: ) from the upper right-hand section of the 
Unifier window to open a contextual menu and click Download Plugins to open the Support 
window. 

The Support window has two tabs: 

 Contact

 Download (opens by default) 

For information about the Contact tab, read the preceding topic: Contact Support. 

Download tab 

In the Download tab, you can see the following plug-in and applications. These plug-in and 
applications are available to download. A link to the installation instructions is available, where 
applicable.  

 Unifier uCAD Plug-in

 AutoVue WebStart

 Unifier Webservices WSDL
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Follow the links within each option to proceed. 

About Unifier 

Click View Help Menu (the question mark icon: ) from the upper right-hand section of the 
Unifier window to open a contextual menu and click About Unifier to access:  

 Version number 

 Copyright information 

 Software agreement details for the Oracle Primavera Unifier 

 Cookie Policy 

 Privacy Policy 

User Control Panel 

The User Control Panel displays the name, and picture, of the person who has signed in. If you 
click the down-arrow, you can access the following features:  

Get Unifier Mobile App

Enables you to open a new window and proceed to download the Unifier Mobile App. 

Preferences

Enables you to access the Preferences window. See Preferences (on page 40). 

Change Password

Enables you to open the Change Password window. 

Last login

Provides the date and time of last log in. 

Sign Out

Enables you to sign out of Unifier. 

Get Unifier Mobile App 

When you click Get Unifier Mobile App, Unifier opens a window. Follow the instructions on this 
window to get Unifier Mobile App for both Android and iOS. 

Preferences 

To access the Preferences (user preferences) window: 

1) From the top right-corner of your window, click your user name to open a contextual menu. 

The menu offers a limited set of choices that are available in the current state. For example: 

 Get Unifier Mobile App 

 Preferences 

 Change Password 

 Proxy For 
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 Last login 

 Sign Out 

2) Click Preferences to open the Preferences window. The Preferences window contains the 
following tabs:  

 General

 Security

 Email Subscription

 Region Format

 Proxy

 More

The following describes each tab. 

General Tab 

Use the General tab to view contact information as in company directory.  

You can include the user's photo of from the left-hand side. The existing Image picker supports 
images of type jpg, jpeg, png, tiff, only. 

You can upload a profile picture by using the Upload Photo option. 

Viewing your Company Contact Information 

Use the General tab of the Preferences window to view your company contact information such 
as the contact's: Name, Title, Email, Work Phone number, Mobile Phone number, Pager 
number, Fax number, and Address (City, State/Province, Zip/Postal Code, and Country/Region). 

Note: The Company Administrator manages user profiles, including the 
contact information. Contact your Company Administrator if you want to 
update your information. 

If the "Hide User Profile" option is selected (by the administrator) in the Company Properties 
(Security tab), then you cannot view the basic information which includes field values such as 
Email address, phone number, etc. This applies to the basic information that is available as a 
part of user profile.  

Example 

Task details in the Workflow BP has To, From, CC fields. If checkbox is checked, then the 
Basic Information block will be hidden. 

Administrator name in Shell landing page and Company landing page. 

User Picker such as Creator in BP forms, shell forms etc. 

Security Tab 

Use the Security tab to change password, manage password reset and recovery (on-premises 
only), and manage secret questions. 

Note: If your company is using Oracle Identity Management (OIM) to 
add users to your company, you must use OIM to manage your 
password. For information on changing your password, see the 
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documentation included with OIM. 

Changing Password 

Use the Security tab (of the Preferences window) to manage password reset (on-premises 
only), password recovery, and selection of secret questions. 

Notes:  

 If your company is using Oracle Identity Management (OIM) to add 
users to your company, you must use OIM to manage your 
password. For information on changing your password, see the 
documentation included with OIM.  

 You cannot recover/reset your password if you do not set up 
password recovery secret questions and corresponding answers. 

 For better security, change your password at regular intervals. Your 
Company Administrator may require you to change it at set times. 

You can change your password in two ways: 

 Using the Security tab of the Preferences window (for first-time users). 

 Using the Change Password option (for returning users). See Change Password for more 
information. 

To change your password using the Security tab of the Preferences  window follow these 
steps: 

1) Go to the Security tab in the Preferences window. 

2) Enter your current password and new password in the Current Password and Password 
fields. 

3) Confirm your new password by entering the new password in the Confirm Password field. 

4) Under Password Recovery Secret Questions section of the Security tab, select a question 
and enter the answer. You can designate up to three secret questions. 

5) Click Apply and click OK to close the Preferences window. 

To change your password using the Security tab of the Change Password option follow these 
steps: 

1) From the top right-corner of your window, click your User Name to open a contextual menu. 

2) Click Change Password to open the Change Password window. 

3) Enter your current password and new password in the Current Password and Password 
fields. 

4) Confirm your new password by entering the new password in the Confirm Password field. 

5) Click Save complete changing of your password. 

You can recover your password from the Sign In Page.  

To recover your password: 

1) Go to the Sign In page. 

2) Click Forgot Password? link to open the Reset Password window. 
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3) Enter your user name and email in the User Name and Email fields. 

4) Click Submit to show the Secret Question. 

Note: If you did not set up the Password Recovery Secret Questions, or 
if your Unifier account is Inactive or On-Hold, you will receive an error 
message instructing you to contact Oracle Customer Support.  

5) Enter the answer to your secret question field and click Submit. A system-generated email 
containing a temporary password will be sent to you automatically. 

6) Click OK in the Alert window.  

7) Go to your email inbox and open the system-generated email titled "Unifier Password Reset 
Notification" and follow the instructions. 

Password/Login Policy

 Minimum overall characters: Minimum number of characters that a password must contain; 
default is one (1).  

 Maximum overall characters: Minimum number of characters that a password must contain. 

 Minimum numeric characters: Password must contain a minimum amount of numbers. 

 Minimum alphabetic characters: Password must contain a minimum amount of letters. 

 Minimum special characters: Special characters are [{~!@#$%&*()-_=+;:"’,<.>/?}]. 

 Password cannot be same as Username: Users cannot use their user name as a password. 

 Password cannot be the same as the user’s First or Last Name: Users cannot use their first 
or last name as a password. 

 Password cannot be same as last password(s): A newly changed password must be 
different from the previously used passwords. 

 Password expiration day(s): If a password expires, users are prompted to change it when 
they next sign in. 

 Inform user before expiration day(s): Upon signing in, users are warned that their passwords 
are about to expire, and are given the opportunity to change the password. 

 Maximum sign in attempts: If a user does not successfully sign in after this number of 
attempts, the account is locked. 

 Suspend inactive user after day(s): Sets the number of days of inactivity before a user 
account is locked. 

Email Subscription Tab 

The Email Subscription tab (Preferences window) enables you to set up email subscription 
details. The Email Subscription tab contains the following blocks and fields:  

 Email Subscription 

 Send notifications in single daily digest 

 Workflow Business Processes 

 Non Workflow Business Processes 

 Portfolio Manager 

 Document Manager - Project/Shell 

 Document Manager - Company 

 Mailbox 
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 User Defined Reports 

 Alerts 

 Gates 

 Project/Shell 

The following provides details. 

Selecting Email Subscription Options 

Email Subscription

The email subscription option enables each user to control the number, type, and frequency of 
Unifier-related email notifications received. Users can subscribe to, or opt-out of, receiving email 
notifications for events within Unifier. 

Send notifications in single daily digest

Select this option if you want to receive your email notifications in a consolidated email, once 
a day (single daily digest), instead of receiving the notification emails individually and per 
event. Deselect this options to receive email notifications individually and per event. 

Note: The maximum number of messages in a single daily digest 
depends on the length of the messages. Unifier will send up to the latest 
100 messages in single daily digest. The older messages will be 
removed and will not be included in the digest.  

Before you begin selecting email subscription options 

Permission

To receive an email notification for a module and/or event, you must have view permission for 
that module and/or event. This view permission is set in Administration mode. 

Note: If you do not have view permission, your email notifications 
settings do not override the original permissions (set by your Company 
Administrator), and you only get email notifications for modules and/or 
events that you have permission to view. 

Document Manager notifications

In addition to module-level view permission, you must also have at least view permission on the 
specific documents or folders that would generate the event email. These permissions are set by 
Company Administrator and from within the Document Manager. In addition, the owner of the 
folder has the option of not generating email notifications for specific events. 

External email accounts

If you are using an email address from a generic email account such as Yahoo, Hotmail, and so 
forth, your spam filter may filter out these notifications. Refer to your email provider regarding 
how to allow these notifications to reach your inbox. 

To receive email notification for a module or event 

1) Go to the More tab in the Preferences window. 
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2) Select your choices from the scrolling window. See the following table for details. 

To opt-out of receiving email notification for a module or event, simply deselect the items from 
the scrolling window.  

To subscribe to or opt-out of email notifications 

1) Go to the More tab in the Preferences window. 

2) From Email Subscription field, select the modules and events for which you want to receive 
email notifications. If you do not select a module or event, you do not receive email 
notifications related to the unselected module or event. The following table for details.  

3) The events apply to the following modules: 

 Workflow business processes 

 Non-workflow business processes 

 Document Manager - Project/Shell 

 Document Manager - Company 

 Mailbox 

 User Defined Reports 

 Alerts 

 Gates 

 Project/Shell 

4) To opt out of receiving email notifications regarding specific Unifier events, deselect the 
checkbox for the notification. 

5) To receive Unifier email notifications in one email summery per day, click the Send 
notification in single daily digest checkbox. The summary email will be sent if one or more 
events trigger an email notification. 

6) When finished, click Apply and OK. 

Notes: 

 For permission-based emails, email notification is usually sent the first 
time permission has been granted and not when permissions are 
modified, unless otherwise noted.  

 Document Manager email notifications are only sent if users have at 
least view permission on the affected item, and if the item owner 
enables email notification. 

Modules and Events Options 

This section describes the events within each module. 

Workflow Business Processes

These events pertain to business processes. To receive notification, you must have at least view 
permission for the business process (BP). You can opt to receive email notification. See the 
following table for details. 
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For When 

Personal tasks You are part of the assignees list when a BP is sent (this becomes a 
task for you). 

Decline tasks A task is declined by one or more of the assignees that you have 
added to a BP that you sent. 

Overdue 
personal tasks

An assigned task is past the due date. 

Messages Someone cc’s you on a BP. 

Discussion 
group 
comments 
(Classic View 
only)

A discussion group participant adds and saves comments within the 
discussion group. You will receive notification if you are the owner of 
the discussion group. 

Record 
Workflow 
Complete

The record Workflow is complete and the Workflow end step has 
been reached; this is applicable on any Workflow BP where user is 
selected as part of the "Notify users on workflow completion" setup 
under the BP Setup > Setting tab. 

Record 
Modification

A certain step occurs in a workflow (if your Administrator has enabled 
workflow actions for the workflow step) that needs action. Actions are 
shown as hyperlinks in the email. 

Non-Workflow Business Processes

These events pertain to non-workflow business processes. To receive notification, you must 
have at least view permission for the business process (BP). You can opt to receive email 
notification. See the following table for details. 

For When 

Record Creation A new record is created. 

Record 
Modification

A record or line item is modified, a line item is added or deleted, 
comments or attachments are added, attachments are removed. 

Document Manager - Project/Shell and Document Manager - Company

Note: With this module in particular, a user modifying multiple 
documents or folders, or folders with many subfolders, can potentially 
trigger a large amount of email. You can prevent receiving too many 
notifications by choosing the digest notification (one email) option, or 
limit the events for which you want to receive notification. 

Users with view permission (set in the Document Manager) on the applicable document, folder, 
or shortcut target receive notification when the following occurs: 
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For When 

Document 
upload

A new document is uploaded into the folder. 

Transfer 
ownership

File or folder ownership is transferred. The new owner is notified. 

Move A document, folder, or shortcut is moved from one location or folder 
to another. 

Delete A document, folder, or shortcut is deleted. 

Document 
revise

A document is revised. 

Folder rename A folder is renamed. 

Mailbox

For When 

Personal 
Mailbox

Users receive email notification when a new Mailbox is received. 

User Defined Reports (UDRs) 

For UDRs, the users receive email notification under following conditions: 

For When 

New report 
granted

The user is granted at least run permission to a user-defined report 
by another user. 

Results from 
scheduled 
reports

When a scheduled report has been generated and the results are 
available; requires run permission be granted for the report. 

Alerts

For alert, the users receive email notification under following conditions: 

For When 

Each alert Users can receive notification when an alert is generated. 

Gates

For When 

Change Phase 
Notification

User receives notification when a phase is changed. 

Auto-email PDF 
Gates run

User receives a PDF copy of an automated gates run. 
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Project/Shell

For When 

Successful 
Creation

Program Manager, Project Manager, or Project Administrator 
receives notification of the successful creation of a Project/Shell. This 
notification occurs if the Project/Shell is created manually, through 
Web Services, using a CSV file, or through auto-creation. 

Portfolio Manager  

For When 

Scenario 
Shared or 
Approved

When the user has defined the list of users, or groups, in the Portfolio 
Manager configuration, then when the scenario sheet is approved or 
shared, the respective list of users, or groups, will receive the 
notification. 

If the list of users, or groups, is defined in the Portfolio Manager 
configuration, but the option in user preferences is not selected, then 
the user will not receive any notification. 

This option is not selected by default. 

The option will also be seen in the "User Preference Template," in the 
Preferences tab. When the "update users" action is performed, the 
value is pushed to the user preferences. 

The subject of email notification that is received by user states if a 
Project Portfolio scenario sheet is approved, or approved and shared.

Note : Only an active user receives the notifications.  

In the Preferences > Email Subscriptions tab > E-Signatures block > E-signature Requests 
option to enable an internal signee to receive email notification for the E-Signature request 
created in the E-Signatures node. When you select the E-signature Requests option in the User 
Preferences, then Unifier sends an email to the user when an E-Signature request is created for 
that user in the E-Signatures node at company, project, or shell.  

When you select Send notifications in single daily digest, and there are notifications relating 
to the E-Signature Requests, then the single digest email to the recipient will contain the 
E-Signature message along with other messages in the email. The header section (where 
hyperlinks to each message within the digest are mentioned) contains the hyperlink to the 
E-Signature message with the text: <Document Name> is sent to you for review and sign. 

Note: You do not have the option to send the document as an 
attachment in the email notification. 

You can send the documents in the Document Manager, and the documents attached to a 
business process record for review and signature to one or more Unifier and non-Unifier users.  

Region Format Tab 

Use the Region Format tab to manage settings such as:  

 Language, date and time format 
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 Language 

 Time Zone 

 Date Format 

 Number and Currency Formats 

 Decimal 

 Digit Grouping Symbol 

 Digit Grouping 

 Show Currency Symbol 

 Positive Currency Format 

 Negative Currency Format 

 Negative Number Format 

This tab provides a Currency Example, also. 

Changing Time Zone and Date Format 

The following settings are maintained in the Region Format tab of your Preferences. 

The Time Zone setting affects the date stamp that appears on the actions that you perform in 
Unifier, such as saving or uploading files, running user-defined reports, and due dates of tasks 
assigned to you. The date stamp is effective as of 12:00 AM in your time zone.  

Example

If your time zone is Eastern Standard Time, and your task is due August 1, then at 12:00 AM 
August 1 your task is due — even if it is only 9:00 PM July 31 in Pacific Standard Time. 

Note: The Time Zone setting is based on the Coordinated Universal 
Time (UTC). 

To set the time zone: 

1) Go to the Region Format tab in the Preferences window. 

2) Click the Time Zone drop-down list and select a time zone based on your locale. 

3) When finished, click Apply and then OK. 

The Date Format determines how date fields appear to you in Unifier. 

To set the date format: 

1) Go to the Region Format tab in the Preferences window. 

2) Click the Date Format drop-down list and select a date format. 

3) When finished, click Apply and then OK. 

Unifier supports the following additional date formats:  

Notes: 

 The time format for all dates is: HH:MM. The Date Format options is 
displayed without AM to support the 24-hour format. For example, in 
the Date Format drop-down, instead of MM/DD/YYYY HH:MM AM, 
MM/DD/YYYY HH:MM is displayed to enable you to select the 
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24-hour time format. 

 Unifier provides you the option to select 24-hour date time format in 
all modules, once this is set in the user preferences (Preferences). 
This is supported for all Standard, Portal, Partner users, and bidders. 

 MM/DD/YYYY 

 DD/MM/YYYY  

 MM/DD/YY 

 DD/MM/YY 

 MM-DD-YYYY  

 DD-MM-YYYY  

 MM-DD-YY 

 DD-MM-YY 

 DD.MM.YYYY  

 YYYY-MM-DD  

 MMM/DD/YYYY  

 DD/MMM/YYYY  

 YYYY/MMM/DD  

 M/D/YYYY  

 M/D/YY  

 D/M/YYYY  

 D/M/YY  

 YY/M/D  

 YYYY/M/D  

 YY/MM/DD 

 YYYY/MM/DD 

Changing Number and Currency Formats 

The following settings are maintained in the Region Format tab of your Preferences window. 

The Number and Currency Formats section of the Region Format tab of your Preferences 
allows you to: 

 Select Preferred Region from a list. This is the region that you want. 

 Set the Decimal Symbol for your currency from a list. 

 Set Digit Grouping from a list. 

 Set Show Currency Symbol to show or not. 

Note: If the administrator does not select the Show Currency Symbol
option, the system ignores the options that are selected for Positive 
Currency Format and Negative Currency Format, and does not 
display symbols. The following applies to all objects (such as Form, 
Sheet, Cash Flow, Dashboard, and Log) that use the Currency Data 
Element. 

 Set Digit Grouping Symbol from a list. 
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 Set Positive Currency Format from a list. 

 Set Negative Currency Format from a list. 

 Set Negative Number Format from a list. 

When finished, click Apply and then OK. 

The Number and Currency Formats section of the Region Format tab also provides examples 
for the following: 

 Currency 

 Decimal Number 

 Integer Number 

The examples show the arrangement of the numbers (the way the numbers are displayed) in the 
forms when a particular formatting option has been selected.  

For decimal numeric data, the precision is governed by the "Decimal Places" set in the Data 
Element properties. 

Note: When the Company Administrator creates a User for the first time, 
when selecting a language, the values of the number formats are 
populated accordingly and displayed in the Region Format tab of the 
Preferences window. The number formatting options are not displayed 
in the User Properties window. The number formatting options are 
displayed in the Preferences window. If the Company Administrator 
changes the language value in the User Properties window, the Region 
Format tab of the Preferences window shows the same languages as in 
User Properties window and the number formatting options remain the 
same. 

Changing Language 

The following settings are maintained in the Region Format tab of your Preferences window. 

To set the language:  

1) Go to the Region Format tab in the Preferences window. 

2) Click the Language drop-down list and select your language. 

3) When finished, click Apply and then OK. 

Note: The languages listed are the active languages selected in the 
Configuration - Internationalization log window, by the administrator.  

The following languages are supported: 

 Arabic 

 Chinese (Simplified) 

 Chinese (Traditional) 

 Dutch 

 English 

 French 
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 German 

 Italian 

 Japanese 

 Korean 

 Portuguese (Brazil) 

 Russian 

 Spanish 

Note: The rendering of Unifier content in Arabic language in third party 
applications (such as Email Client, Adobe for PDF, and so forth) is 
outside of the Unifier application purview.  

Numeric Format Based on Language Selection  

The Numeric formats such as the decimal symbol, grouping, and so forth are based on the 
language selected for the bidder. 

For the Vendors records that are created through CSV or Web Services, the user can specify 
the values for the Language, Time Zone, and Date Format Data Elements and create Vendors 
records in Bulk. The existing codes for these fields can be used to specify the values. The list 
below is derived from the Java API. 

Langua
ge 

Region 
Format 

Decim
al 
Symb
ol 

Digit Grouping 
Symbol 

Digit 
Groupi
ng 

Positive 
Currency 
Format 

Negative 
Currency 
Format 

Negative 
Number 
Format 

Simplifi
ed 
Chines
e 

Chinese 
(Simplified, 
PRC) 

. 
(perio
d) 

, (comma) 
123,45
6,789 

#123 #-123 -123 

Traditio
nal 
Chines
e 

Chinese 
(Traditional
, Taiwan) 

. 
(perio
d) 

, (comma) 
123,45
6,789 

#123 -#123 -123 

Dutch 
Dutch 
(Netherlan
ds) 

, 
(com
ma) 

. (period) 
123,45
6,789 

# 123 # -123 -123 

English
English 
(United 
States) 

. 
(perio
d) 

, (comma) 
123,45
6,789 

#123 (#123) -123 

French
French 
(France) 

, 
(com
ma) 

Space 
represented by 
blank in the 
product 

123,45
6,789 

123 # -123 # -123 

Germa German , . (period) 123,45 123 # -123 # -123 
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n (Germany) (com
ma) 

6,789 

Italian 
Italian 
(Italy) 

, 
(com
ma) 

. (period) 
123,45
6,789 

# 123 -# 123 -123 

Japane
se 

Japanese 
(Japan) 

. 
(perio
d) 

, (comma) 
123,45
6,789 

#123 -#123 -123 

Korean
Korean 
(Korea) 

. 
(perio
d) 

, (comma) 
123,45
6,789 

#123 -#123 -123 

Portug
uese 

Portugues
e (Brazil) 

, 
(com
ma) 

. (period) 
123,45
6,789 

# 123 -# 123 -123 

Russia
n 

Russian 
(Russia) 

, 
(com
ma) 

Space 
represented by 
blank in the 
product 

123,45
6,789 

123# -123# -123 

Spanis
h 

Spanish 
(Spain) 

, 
(com
ma) 

. (period) 
123,45
6,789 

123 # -123 # -123 

Proxy Tab 

Use the Proxy tab to:  

 Prevent assigning proxies (Do not allow Proxies) 

Note: The Do not allow Proxies option is available for the Company 
Administrator (and in Admin mode), only. 

 Add multiple proxies (My Proxy tab: Users who can act as my Proxy) 

 See the list of users who can act as your proxy (My Proxy tab: Users who can act as my 
Proxy) 

 See the list of users who you act as their proxy (I am Proxy tab: Users I can act as their 
Proxy) 

 See the history of proxy login (Proxy Login History tab) 

You can select/designate more than one proxy user. 

You can be a proxy for multiple people, and you can designate more than one user as your 
proxy. 

Proxy users can be granted permission to access another user’s account to complete tasks and 
perform other functions on that person’s behalf. When another person signs in as your proxy 
user, that person will have access to all of the records and functions that you do.  
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When you designate another user as your proxy, the user will have access to all of: 

 The records that you have generated 

 The functions that you perform 

When you designate another user as your proxy, the user will not be able to change your 
Preference settings and the Audit logs reflect the actions taken by a proxy user as "on behalf of" 
the original user. 

You can limit the period in which the proxy user will have access to your account by specifying a 
start and end date or leave their access active indefinitely. 

Proxy users who are active (Status: Active) receive email notification of tasks to perform as 
proxy. This applies during the time specified time period, using the Start Date/Time and End 
Date/Time. 

Note: If the proxy user must receive task notifications immediately, ask 
the proxy user to ensure that the Send notifications in a single daily 
digest checkbox is not selected. See Selecting Email Subscription 
Options (on page 44) on the Preferences window, More tab. 

Do not allow Proxies 

Only Site/Company Administrators, Company users, and Partner users are permitted to select 
the Do not allow Proxies option. 

Note: This option is read-only in the user's Preferences window. 

Users are able to add proxy users in their Preferences window only if the Site/Company 
Administrator has not checked the Do not allow Proxies option in the Proxy tab of Edit User 
window. 

The Proxy tab contains the following tabs: 

 My Proxy tab 

This tab enables you to determine the users who can act as your proxy (Users who can act 
as my Proxy). This tab of the Proxy tab lists the users who can act as your proxy and allows 
you to add, adjust the settings, remove proxies, and view the proxy login history. 

If you have access to more than one Company and want to assign a proxy for yourself in 
those companies, you need to go into each Company and set the proxy user (Company > 
your user name > Preferences > Proxy). 

The topics that follow describe available user preference configuration settings for each tab, 
in details. 

 I am Proxy tab  

This tab enables you to determine who you can be a proxy for (Users I can act as their 
Proxy). 

 Proxy Login History tab  

This tab enables you to see a history of all proxy logins. 
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Choosing a Proxy User 

Add (plus "+" icon) 

If the Do not allow Proxies option is selected by your Site/Company Administrators, then this 
option is not available for you to use. 

If the Do not allow Proxies option is not selected by your Site/Company Administrators, then 
you can use this option to grant proxy access to other users. To add a proxy, click Add and 
follow the prompts. 

Note: Your Company Administrator can assign other users to act as 
proxies to your account. if you are unable to do so. 

Settings

If the Do not allow Proxies option is selected by your Site/Company Administrators, then this 
option is not available for you to use. 

If the Do not allow Proxies option is not selected by your Site/Company Administrators, then 
you can use this option to select an existing proxy and change the user settings of your proxy, 
such as start and end date/time. To change the user settings of your proxy, click Settings and 
follow the prompts. 

The system sets the values in the time-related fields base on the user's preferred data and time 
formats. 

If you do not specify a start or end date, the proxy user can access your account immediately 
and their access privileges will not expire. 

You can select Active to activate your proxy's access. To disable your proxy's access, select 
Inactive. 

Remove

You can use this option to remove a selected proxy. To remove a user as your proxy, click to 
select the proxy from the list and click Remove. 

Proxy Login History

Use this option to view the following information about your proxies: 

 Name 

 Login Date 

 Logout Date 

The last login information appears on top. 

Users I can act as their Proxy 

If the Site/Company Administrator has designated you as a proxy for another user, your user 
name is listed under Users I can act as their Proxy field. 
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Note: As a proxy of a user, you have all the permissions that have been 
granted to that user except that you cannot change the user's original 
Preference settings even if the user has Administration permissions.  

To log in as someone else’s proxy user: 

1) From the top right-corner of your window, click your User Name to open a contextual menu. 

2) Click the Proxy For link to see a list of the users who designated you as their proxy. 

3) Click to select the user name. 

4) Select the user account to which you want to log in as a proxy. 

5) Click Proxy Login. The Unifier Home page opens, and you are immediately acting on behalf 
of the user. 

To log out as a proxy user: 

Click the Sign Out link at the upper right portion of the Unifier window. Your Proxy session will 
end, but you will still be signed in to Unifier under your own user name. 

More Tab 

Use the More tab to manage company settings such as:   

 Viewer Options 

 Default Viewer 

 Viewer Exceptions 

 Always use Native 

 Always use Unifier 

 Default Login View 

 User Custom Dashboard as default login view 

Choosing a Viewer Option 

The following setting is maintained in the More tab of the Preferences window. 

Note: Before you choose a file viewer option, you must have an active 
AutoVue license and AutoVue installed and configured on your server.  

The file viewer option determines how Unifier displays files (such as documents or drawings) 
that are attached to business processes or stored in the Document Manager and opened from 
within Unifier. 

You can choose a default viewer, which will be used to open most file types in Unifier. You can 
also specify exceptions to this; for example, you may choose Unifier Viewer as the default 
viewer, which will be used to open most file types, but then choose to open a few file types such 
as drawing files and image files using the native software applications that reside on the user's 
desktop machine. 

To select a file viewer option: 

1) Go to the More tab in the Preferences window. 

2) Click the Default Viewer drop-down list and select one of the following viewer options: 
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 Native 

 Unifier Viewer 

3) When finished, click Apply and then OK. 

The following describes each of the default file viewer options in details: 

Native

To open documents in their native software applications (for example, Microsoft® Word 
documents are opened in Microsoft Word). In order to be able to use this option to view files, 
you must have the native software application installed on your computer.  

Note: The native software application does not display the document 
graphical markups, but Unifier displays the document graphical markups 
automatically, using the Unifier Viewer. 

Unifier Viewer

To open documents in system-provided Viewer which will convert most file types to an image 
format. 

Note: If you select Unifier Viewer, the document opens in read-only 
view, but it supports adding graphical markups and text comments (for 
example, in attachments to business process and other records, or in 
files in the Document Manager). 

Setting Viewer Exceptions 

The Viewer Exceptions section of the More tab allows you to specify exceptions to the default 
viewer of your choice. 

Example 

If you selected “Unifier Viewer” as your file viewer and want “Native” to show a particular 
extension and not the “Unifier Viewer,” enter the extension in the “Always Use Native:” field. 

If you selected “Native” as your file viewer and want “Unifier” to show a particular extension 
and not your Native software, enter the extension in the “Always Use Unifier:” field. 

Notes: 

 Omit the period before the extension. 

 Separate multiple extensions by a semicolon, with no space in 
between. 

Changing Unifier Default Landing Page 

Note: This section applies to on-premise users, only. 

The following settings are maintained in the More tab of the Preferences window. 

When you sign in to Unifier and the application opens, you see the Home page ( ) view as the 
landing page, by default. You can change the landing page view to a custom dashboard of your 
choice at company-level, only. 
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You can choose from the configured custom company-level dashboards by selecting a 
dashboard from the Available Dashboards drop-down list in the dashboard view. 

To change the landing page view to a custom dashboard: 

1) Go to the More tab in the Preferences window. 

2) Select Use Custom Dashboard as default login view, next to the Default Login View field. 

3) Click Apply and OK. 

Change Password 

From the top right-corner of your window, click your user name to open a contextual menu. Click 
Change Password to open the Change Password window. In the Change Password window 
you can: 

 Change your Unifier password. 

 View password policy. 

Sign Out 

From the top right-corner of your window, click your user name to open a contextual menu. Click 
Sign Out. For additional details, see Sign In, Sign Out, and Session Timeout (on page 25). 

Company Landing Page (User) 

When you (a user or an administrator) sign in to Unifier, the system is in the user mode, by 

default. You can switch between modes using the mode icon ( ). 

Note: The Home page  does not support the Admin mode. 

To access company user functions in Unifier, go to the Company Workspace tab and click 
User mode to open the company landing page ( or company home page). 

To access your company landing page (User):  

1) Click your company tab (Company Workspace) to open it. 

2) Switch to User mode. 

3) From the left-hand Navigator, on the very top, click your company name (for 

example: ) to open the company landing page, the Company Workspace
window (log). 

The Company Workspace window has the following tabs:  

 General

 Summary

You can add multiple tabs to the company landing page. To add a new tab: 

1) Click the pencil icon (under the mode icon) to open the Company Dashboard window. The 
Company Dashboard window lists the existing tabs and enables you to add, modify (edit), 
or delete tabs. 
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2) Click the Create Tab option (the plus "+" icon) to open the New Tab window. 

3) Enter a name in the Tab Name field, and click Save. 

The newly created tab will be listed under the existing tabs on the Company Dashboard
window. 

You can add multiple blocks (custom or standard) to each tab of the company landing page: To 
add new blocks to a tab: 

1) Click to select the tab. 

2) Click the plus "+" icon (on the right-hand side of the screen) drop-down arrow and select one 
of the following types of blocks: 

a. Custom

b. Standard

To add custom blocks on a tab: 

1. Click to select a tab. 

2. Click Custom to open the New Custom Block window  

3. Enter the values (Source Details, Block Title, Block Length, etc.) in the fields and click 
Save. The new block is added to the right-hand pane. 

To add standard blocks on a tab: 

1. Click to select a tab. You can add both custom and standard blocks to a tab. 

2. Click Standard  to open the New Standard Block window  

3. Enter the values (Source Details, Report On, Block Title, Block Length, etc.) in the fields 
and click Save. 

The Data Type drop-down field (under the Source Details block) enables you to include 
workspace type information (such as Active Workspaces, On-Hold Workspaces, etc.) on 
the company landing page. Click the Data Type drop-down field, click to select 
Workspace Information, and click Save. 

To delete or edit a block use the trash-can or pencil icons. 

You can: 

 Edit a tab name by selecting the tab and using the Edit Tab icon (the pencil icon) on the 
Company Dashboard window. 

 Delete a tab by selecting the tab and using the Delete icon (the trash-can icon) on the 
Company Dashboard window. You cannot delete the General tab or Summary tab 
because they are system-generated tabs. 

 Reorder the tabs that are displayed on the Company Dashboard window by way of 
drag-and-drop. 

 Select which tabs to be displayed on the Company Dashboard window by selecting the tab 
(the select box). You cannot deselect the General tab. 

 Print a tab or maximize a tab by using the print icon or the maximize icon, respectively. 

The General tab is divided into two sections: 

 The left-hand section displays the following information: 

 Company name and image (if it exists in the Company Properties page). 

 Description
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 Administrator

 Homepage url

 Locations

Other locations, if available, appear as grouping nodes in expanded mode below the first 
address, and the map picker displays the pin markers for all other locations. 

 The right-hand section displays the following information in multiple blocks: 

 Tasks

 Notifications

 Company Workspace records: Workflow Business Processes

The Workflow BPs are all the workflow records for the user who has signed in. If the user 
who has signed in does not have access to any of the Workflow BPs, at the Company 
Workspace level, then the panes display a pertinent message. You can click on the 
BP name to navigate to the respective BP log. 

 Company Workspace records: Non-Workflow Business Processes

The Non-Workflow BPs are all the non-workflow records for the user who has signed in. If 
the user who has signed in does not have access to any of the Non-Workflow BPs, at 
the Company Workspace level, then the panes display a pertinent message. You can 
click on the BP name to navigate to the respective BP log. 

The Summary tab contains summary information displayed within custom or summary blocks. 
Similar to the General tab, you can add, edit, or delete custom and standard blocks. 

Shell Landing Page (User) - Details 

To access your shell landing page (User):  

1) Click your shell tab to open it. 

2) Switch to User mode. 

3) Click My Dashboard and click Details to open the shell Details form. 

For more information about the shell landing page, refer to the Unifier Programs, Projects, and 
Shells User Guide. 

The shell Details form enables you to access the following tabs: 
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Tab Description 

Genera
l

This tab has the following blocks: 

 Detail Form Tab Name 

 AP Block to BP 

 Link Multiple P6Projects 

This tab enables you to see and set the following general information about 
the shell: 

 Number 

 Administrator 

 Location 

 Description 

 Status 

 Latitude 

 Longitude 

The fields in the General tab can be customized. You can format the columns 
when your Display Type is set as Table or Grid. This enables you to re-size, 
for example the Dashboard View Mode for the Drill-downs, and Standard, or 
Custom, blocks that the selected Display Type is set as Table or Grid. This is 
similar to the same feature available for the Business Processes log. Unifier 
saves your customized display automatically until it is changes by another 
user.  

You can also reorder the fields under the Detail Form Tab Name. Use the Edit 
Details Block option (New Standard Block window) to select fields columns 
(Selected Fields) by dragging and dropping the fields from the Available 
Fields. You can also use the deflector and collector options. 

This action makes the order in which the fields are displayed in the Details 
block of Dashboard match the order defined in the Selected Fields column in 
the New Standard Block window. 

Curren
cy

In this tab, you can: 

 See the currency that the shell uses. 

 Add new currency. 

 Modify an existing currency. 
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Images This tab contains the following toolbars:  

Image (the plus "+" symbol) drop-down menu: 

 Browse: To upload images from the local computer, directly. You can 
select and add multiple images. If you select multiple images, the images 
will be displayed in the shell dashboard, on the image block, as rolling 
images. 

 Document Manager: To see the image files and folders that are available 
in a shell Document Manager. You must have the "View" permission to 
see the images and folders. Use this option to upload images from the 
local Document Manager (DM) of the particular project. If an image is 
revised in DM, the revised image is displayed in the shell dashboard, on 
the image block. You will be able to view images, from DM, in the 
Dashboard in Admin as well as User modes. 

In the dashboards, if there are multiple images, then Unifier displays all of 
the images as rolling images.  

When a shell has multiple images, Unifier uses the first image from the list 
to print the shell image through custom prints and reports.  

Help (the question mark "?" symbol) option: To access help. 

The tab also contains a log that lists the names of the images that you have 
downloaded. You can use drag-and-drop to reorder the images on the log. 
Use the trash-can icon to delete an image. 

Option
s

Enables you to see, add, and set options about the shell such as:  

 Phase 

 Financial Period 

 Email Address 

 Send Notification To 

 Document Manager Attribute Form 

 Document Manager Attribute Form Used 

 Time Zone for Background Jobs: This time zone will be used to calculate 
the time for running the recurring jobs, specific to this workspace. If left 
blank, the time zone that was set in the Background Jobs (at 
Company-level) will be used to run the jobs. 

Links Enables you to add new links and see the existing links in the shell under the 
following blocks on the window: 

 New Links 

 All Links 

Calend
ar

Enables you to select one of the following calendar types: 

 Standard Calendar 

 Custom Calendar (you can copy an existing custom calendar) 
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Integra
tion

This tab enables you to: 

 Link Multiple P6 Projects 

 P6 Project ID 

 Project Name 

 Schedule Type 

Opening records from drill-down Tables and Grid 

When in a drill-down, the selected Display Type is Table, or Grid, and the Record Number is 
selected in the Source Group By, the Record No. turns to a hyperlink. You can click on the 
Record No. to open the record in a pop-up window.   

Note: The linked record will only be displayed if you have View or Modify 
access for the BP record. 

The BP records are displayed per enhanced user interface, when available and enabled. If the 
enhanced user interface is disabled, then the BP record opens in classic view. 

The Record Number will not be a hyperlink for the following: 

 When source of the selected Data Cube (in Drill-down block) is Data View. 

 In the Drill-down block, when the data is selected from the Current Shell and sub-shells or 
from sub-shells, only. 

 If the selected Data cube has multiple BPs added as the Data Source. 
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Dashboard and Tabs 

This section explains the following elements of Unifier interface: 

 Dashboard 

 Tabs 

Dashboard (on-premises only) 

Unifier displays the Dashboard icon (  ) only if you have access to a company dashboard. 

The following lists the Dashboard page features: 

 Fixed height and width 

 Displays a chart 

 Always remains as the first tab, so it cannot be reordered like other tabs 

 Is not included in the scroll area, so it remains in place to the left of the scroll controls 

Tabs 

Unifier uses tab-based navigation. You can use tabs to navigate to frequently used locations 
such as: 

 Company Workspace 

 Shells (single-instance or multiple-instance) 

 Projects 

 Programs 

Unifier allows you to: 

 Create, and use, unlimited number of tabs. 

 Rearrange your tabs locations on the screen. You can arrange tabs by dragging the tabs. 

 Close all tabs (except one).  

To create a new tab, click the plus (+) sign next to the existing tab on your screen. Use 
drag-and-drop to arrange tabs. 

Note: When tabs no longer fit on the page, Unifier provides scrolling 
option and drop-down list to assist you with accessing all your tabs. 

You can also create multiple tabs representing the same location to quickly navigate to, or in, 
different areas within that location.  

Tabs maintain their states if you switch tabs. 

Example 

You are working in Schedule Manager (User mode) and decide to switch to another tab and 
switch back. 

Unifier preserves your setting, Schedule Manager (User mode). 

Similarly, when you sign out of Unifier and sign in again, you return to the tab that you were 
working with, before you signed out, with your settings preserved. 



Unifier General User Guide

66

Note: First-time Unifier users see only the Home page. Returning users 
see all the tabs that were displayed in the previous Unifier version. 
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Bookmarks 

The function of bookmarks in Unifier is similar to the bookmarks that you create in a web 
browser to help you access a web page more quickly, or navigate to frequently used locations.  

Note: Unifier does not validate bookmark names, so ensure that you do 
not add duplicate or confusing bookmark names.  

You can add bookmarks to Unifier User Mode functions where you frequently work.  

Note: You cannot add bookmarks in Admin mode. 

To add bookmarks: 

1) Go to the tab/node that you want to bookmark. 

2) From the top right-hand corner, click the Star icon to open the Bookmarks window. The 
name of the tab/node appears in the Name field. You can modify the name for your 
bookmark, if you wish. 

3) Click Add to create a bookmark.  

4) Close the Bookmark window by clicking outside the Bookmark window. 

Note: Accessing a tab/node through a bookmark is based on your user 
permissions. 

To use bookmarks, from the top right-hand corner, click the Star icon to open the Bookmarks
window. 

Provided that you have permission to access that module, clicking on a bookmark opens the 
shell or project. The breadcrumbs (locator links) to your current location appear in the upper 
left-corner of the Unifier window. 

Note: If you do not have permission to access a module that you 
designate as the default, Unifier displays the home page. 

To delete, or move, a bookmark: 

1) Open the bookmark window. 

2) Scroll on the bookmark that you want to delete/move. 

3) Hover over the bookmark. 

4) Click the gear menu ( ) and click Delete/Move Up/Move Down. 

To rename a bookmark: 

1) Open the bookmark window. 

2) Scroll on the bookmark that you want to rename and click to open the bookmark. 

3) Open the bookmark window, again. 

4) Change the bookmark name in the Bookmarks field. 

To make a bookmark as your default bookmark: 
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1) Open the bookmark window. 

2) Scroll on the bookmark that you want to make as your default bookmark. 

3) Click the checkbox, under the Default column, to select the bookmark. 

Note: If you do not wish to designate a bookmark as the default module 
shown to you at sign in, ensure that none of the bookmarks are selected 
before you close the Bookmarks window. 
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Home Page 

Use the Home icon to open the home page. The page contains the following nodes and 
sub-nodes:  

 Home

 Tasks

 Drafts

 Mailbox

 Inbox

 Notifications

 Sent Items

 Master Log - Business Processes (master log) 

The following explain each node and sub-node in details. 

In This Section 

Home Page (Home) ................................................................................................ 69 
Home Page (Tasks) ................................................................................................ 70 
Home Page (Drafts) ................................................................................................ 70 
Home Page (Inbox) ................................................................................................. 72 
Home Page (Master Log-Business Processes) ....................................................... 73 

Home Page (Home) 

The upper part of the Home sub-node page displays the following interactive tiles: 

 Tasks

 Notifications

 Mail

The lower part of the Home sub-node page displays the following interactive tiles, if applicable: 

 My Active Tasks

 Task Distribution

 Workflow Business Processes

 Non-Workflow Business Processes

Click a tile to navigate to the respective log. Charts on the left panel display number of active 
tasks by status and workspace distribution. Tables in the right panel display number of tasks by 
business process type and status in your workspaces. 
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Clicking a business process name link takes you to its log in the corresponding workspace 
(company or project). 

Home Page (Tasks) 

Click the Tasks sub-node to access all your tasks. You can access your Tasks from the left 
navigator or by clicking the Tasks tile on the Home sub-node. For more information, see 
Reviewing your Tasks and Working with Tasks. 

Home Page (Drafts) 

Click the Drafts sub-node to see all the business processes that are in a preliminary version. 
You can navigate to the Drafts node from the left navigator. 

The following columns and icons are displayed in the log: 

 Attachment icon (displays if the upper form of the drafts has any attachments) 

 Business Process (Name of the BP) 

 Record Number (Record number of the Draft) 
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 Title (Title of the draft) 

 Origin (The source name where the draft was created) 

 Last Saved (The date that the draft was last saved) 

 Discussion (Discussion associated with a draft). Classic View only. 

From the Drafts log, you can use the gear menu ( ) to perform the following actions: Open, 
Go to Origin, and Delete. 

When a draft record is selected from the log, the Record Details, Workflow Progress, and 
Attachments tabs are displayed on the right pane. 

Toolbar 
Option 

Description 

Actions The following option is displayed: 

Delete: to delete drafts. 

View To customize the view according to the following criteria: 

 Saved in last 7 days 

 Saved in last 30 days 

 Group by Business Process 

 Group by Origin 

 All Drafts 

 Create New View... 

 Manage Views... 

This sub-menu will also contain all views that you have created. 

Refresh 
( )

To refresh the log screen. 

Print ( )
To print the contents of the log, export to CSV, or export to Excel.  

Edit View 

( )

To edit the view of the log. You can edit the view of the following elements 
on your log: 

 Columns

 Filters

 Group By

 Sort By

If you modify the view and do not save the changes, the system keeps the 
existing name and adds the word "Modify" to the existing name. You can 
click Clear to clear your selections. 

Search To open the Search window and enter search parameters. You can 
search for drafts that are not currently displayed in the log. 

Find on 

Page 

The Find on Page option enables you to find items on the displayed 
page. 

When you click the Find on Page option, the system inserts a new row 
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Toolbar 
Option 

Description 

that enables you to enter your filter parameters. 

Home Page (Inbox) 

Unifier Mailbox has the following functions:  

 An internal email feature that allows Unifier shell team members to communicate with each 
other and maintain a record of the communications. For shells with View-Only status, 
Mailbox is available for viewing, but you cannot send, edit or delete messages. 

 The repository that collects external emails related to the shell. These emails can come from 
shell users or from external users who do not use Unifier. From the Mailbox, users can 
forward the emails to appropriate members, flag them for review, and reply to them. In 
addition, these external emails can be linked to business process records. 

 A cross-shell listing of your Inbox can also be accessed in the Mailbox node of your shell. 
Refer to the Unifier Programs, Shells, and Projects User Guide for details. 

 A cross-project listing of your Inbox can also be accessed in the Mailbox node of your 
project. The Mailbox node displays all of the internal and external emails in a project. 

Replies from external users can be tracked and monitored from within your Project Mailbox. 
Refer to the Unifier Programs, Shells, and Projects User Guide for details. 

To view all your email messages (Mailbox) across shells 

1) Go to the Home page.  

2) In the left Navigator, click Inbox. All messages sent between shell team members
(messages residing in all shell Mailbox Inbox and Sent folders) are listed. 

3) To open a listed message, select it from the list and click Open. 

When an email is selected from the Inbox log, the contents of the email are displayed on the 
right along with the possible actions. 

You can use the gear menu  ( ) to perform the following actions: Open, Flag (All available 
options are displayed), Clear Flag, and Delete for each record. 

The following toolbar options are displayed on the Inbox log: 

Toolbar 
Option 

Description 

Actions The following options are displayed: 

Flag: To flag one or more emails. All available sub-options are displayed. 

Clear: To clear the flags. This option is context-sensitive. 

Print: To print the log. 

Delete: Delete one or more emails. 
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Toolbar 
Option 

Description 

View To customize the view according to the following criteria: 

 Received in last 7 days 

 Saved in last 30 days 

 Group by Business Process 

 Group by Origin 

 All Items 

 Create New View... 

 Manage Views... 

This sub-menu will also contain all views that you have created. 

Edit View To edit the view (columns) of the Inbox log. 

Search To open the Search window and enter search parameters. You can 
search for items that are not currently displayed in the log. 

Find on 

Page 

The Find on Page option enables you to find items on the displayed 
page. 

When you click the Find on Page option, the system inserts a new row 
that enables you to enter your filter parameters. 

Refresh 
( )

To refresh the log screen. 

Home Page (Master Log-Business Processes) 

Note: The name of this node can be customized. 

Click the Master Log - Business Processes node in the Navigator (left-hand pane) to see all of 
the business processes that you are involved in and you have permission to access. The 
business processes log displayed (for each of the business processes under the Master Log - 
Business Processes node) is driven by the log design of the respective business process. 

Note: If you do not have permissions to view any of the business 
process types listed under the Master Log - Business Processes node 
(master log), then you will not see the Master Log - Business 
Processes node in the Home page. 
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Unifier User Mode 

Primavera Unifier has two modes of operation. 

 User mode: Used to enter and access information, and perform tasks within Unifier. Most 
Unifier users do their work in User mode. 

 Admin mode (Administration mode): Used for all administrative tasks within Unifier to set up 
and configure features and modules. Access to Admin mode functions is usually limited to a 
few users within a company. 

Access to Unifier functionality is granted through Permissions. The ability to utilize a specific 
function in Unifier depends on Permissions settings (accessed in Admin mode). 
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Unifier Modules Overview 

The following table defines which modules (and some functionality) are available in Unifier at the 
Company level, Program level, or in Projects (Standard) or in shells (Generic or CBS).  

Note: Unifier displays the Tasks, Notifications, and Drafts nodes, in 
the respective Company Workspace and Project/Shell, based on the 
deployment of your user mode navigators. 

Module or 
Functionality 

Company Program 
Project 
(Standard) 

Shell (CBS)
Shell 
(Generic) 

Accounts Sheet X 

Action via email on 
workflow business 
processes 

X X X X 

Alerts X X X 

Asset Manager X 

Bookmarks X X X X X 

Bulk task actions X X X 

Bulk update business 
process records 

X X X X 

Bulk update of shells X X 

Bulk update of 
planning items 

X 

Bulk update of assets X 

Bulk update of generic 
manager records 

X X X X 

Bulk user 
management 

X X X 

Cash Flow X X X X 

Commitment 
Summary 

X 

Configurable 
Dashboard 

X X 

Cost Manager 
(generic) 

X 

Cost Manager (CBS) X X X X 

Custom Dashboard X X X 



Unifier General User Guide

78

Module or 
Functionality 

Company Program 
Project 
(Standard) 

Shell (CBS)
Shell 
(Generic) 

Custom print for 
business processes 

X X X X 

Custom reports X X X X 

Document Manager X X X X 

Earned Value X X 

Funding X X X 

Gates X X X 

Generic Manager X X X X 

Geocoding on 
business processes 

X X X X 

Geocoding on shells X X 

Lease Management X 

Planning Manager X 

Resource Manager X X X 

Rules X X X 

Schedule Manager 
and Scope 
Management 

X X 

Schedule of Values 
(General Spends and 
Payment Application) 

X X X 

Space Manager X X 

Summary Dashboard X X X 

System Usage Report X X X X X 

uDesigner X 

Mailbox X X X 

User-defined Reports X X X X X 

User Mode Navigator X X X X X 
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Common Procedures 

This section summarizes some procedures that are the same or very similar in different sections 
and modules within Unifier. 

In This Section 

Queries ................................................................................................................... 81 
Attaching Files ......................................................................................................... 89 
Adding Images ........................................................................................................ 92 
Adding Hyperlinks ................................................................................................... 93 
CSV File .................................................................................................................. 93 
Importing Data from an Outside Data Source into Unifier ........................................ 96 
Searching and Finding in Unifier ............................................................................ 104 
Searching and Finding a Shell ............................................................................... 106 
Searching in Managers Logs ................................................................................. 109 
Searching in Document Manager Node (Standard View) ....................................... 109 
Searching Date Fields ........................................................................................... 114 
Searching Mailbox Log, Notifications Log, and Sent Items Log (Home Page) ....... 115 
Searching Sheets .................................................................................................. 117 
Searching Pickers ................................................................................................. 118 
Internationalization ................................................................................................ 119 
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Queries 

You will be using queries to extract data from the database for reports and data pickers, and to 
set up auto-creation with creator elements.  

A query is a data mining tool—a method for retrieving information from a database. A query 
filters the information returned from the database according to restrictions or conditions you 
specify. The Unifier queries can: 

 Filter or narrow the data being retrieved for use in reports and manager sheets 

 Set up conditions or triggers to make something happen automatically in Unifier 

 Filter or narrow the data being retrieved for use in a data picker element 

In This Section 

How Queries Work .................................................................................................. 81 
Using Formulas or Conditions in Queries................................................................. 82 
Assignee Filter Query Condition .............................................................................. 86 
Query Based Data Element (QBDE) ........................................................................ 87 

How Queries Work 

The way queries work in Unifier is as follows: 

 You mine down to the information you want by choosing an element (field) in the database 
on which to base the query. 

 You test the data against conditions and values you specify. 

A condition is a state or restriction the value in the data element (field) must meet. A 
condition of the value might be that it must be equal to a certain number (maybe 10) or that it 
must contain a certain string of letters (such as "due date of"). 
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 When (or if) the data meets the condition you specify, Unifier retrieves if from the database 
for use in a report, manager sheet, auto-creation, data picker, etc. 

Using Formulas or Conditions in Queries 

For queries, you can evaluate the data before retrieving it from the database to determine 
whether or not to include the value in the report, manager sheet, or data picker, or to spawn an 
auto-creation. To evaluate the data, you can use a formula or a condition. 

In formulas, multiple fields can be calculated to arrive at a certain value that the data must meet 
before it will be used. The value can be one that you enter, or a value from another field. 

You can include formulas in conditions. 

In the Condition field, select the condition the value in the field must meet.  

The following explains the formulas you can use in a query. 
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Field Value Comparison 

The formula for field value comparison produces data that meets a field value (string or numeric) 
from the form of a business process or a shell in a hierarchy, or a constant. Used to populate a 
data picker. 

Date Plus or Minus 

The formula for date adds or subtracts a value to or from a date. 
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Date Difference 

The formula for date difference subtracts one date from another to give you the number of days 
between the dates. 

Compare Date Fields 

You can also compare date fields as part of a query. 
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Dynamic Date Value 

You can compare a date field value with a date field from the form of a business process or a 
shell in a hierarchy, a specific date, or today’s date, and also add or subtract days to the result. 
Used to populate a data picker. 
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Between Dates 

You can compare a date field value to see if it falls between two dates. Used to populate a data 
picker. 

Assignee Filter Query Condition 

When you are setting up a business process, you can filter the condition for the assignee 
according to: 

 Contains 

 Does not contain 

 Exists in 

 Does not exist in 

 Equals 

 Does not equal 

 is empty 

 is not empty 

The following is an example of query evaluation. The workflow setup follows these policies for 
selecting users. 

Assignee Query Field (Role as defined in the User Attribute Form) 

A Approver 

B Reviewer 
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Assignee Query Field (Role as defined in the User Attribute Form) 

C Controller-Approver 

D Controller 

E Reviewer-Submitter 

F Submitter 

G Approver 

The following shows examples with condition/operator: 

Condition/Operator Business Process Form (Field value)

Example of the data source used. 

Filtered List of 
Assignees 

exists in Controller-Approver A, C, D, G 

Reviewer B 

does not exist in Controller A, B, C, E, F, G 

Note: If the workflow setup has any of the new operators, the list of 
assignees that the user sees at runtime honors the stated query 
parameters. 

The following shows examples with value, condition/operator, and result:  

Value 1 Condition/Operator Value 2 Result 

ABC exists in ABC, BCD, CDE True 

XYZ exists in ABC, BCD, CDE False 

ABC does not exist in ABC, BCD, CDE False 

XYZ does not exist in ABC, BCD, CDE True 

ABC, BCD, CDE contains ABC True 

ABC, BCD, CDE contains XYZ False 

ABC, BCD, CDE does not contain ABC False 

ABC, BCD, CDE does not contain XYZ True 

Query Based Data Element (QBDE) 

In Unifier, a Query Based Data Element (QBDE) enables you to view data from the Upper Form 
or Detail form of a Business Process. QBDE also enables you to view data from: 

 Other Business Processes 

 Sheets 
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 Cash Flow 

The QBDEs are based on the “SYS Numeric Query Based” Data Definition (DD), and the query 
for these QBDEs is set in the Business Process Configuration setup. See the "Configure a 
Query for a Query Based Data Element on a BP" for additional details. 

In addition to the Web interface (Unifier Application in the browser), the system evaluates QBDE 
in the following areas: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

 Bulk Edit 

 Bulk Update 

 Creating BP records using BP Template 

Evaluating Query Setups of Data Picker Data Elements 

Unifier supports many types of Data Picker DEs. The Administrator can set up Query conditions 
on these Data Picker DEs to filter the results. When a Data Picker DE is launched in the Web 
interface (Unifier Application in the browser), the system runs the query and displays the records 
based on the queries defined in uDesigner. The system evaluates the data picker query 
conditions in the following areas, as well: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

The following is a list of the supported Data Pickers: 

 BP Data Picker 

 Shell Data Picker 

 User Data Picker 

 CM Data Picker 

 Role Data Picker 

See the "Importing Configuration Packages" section for more information about importing data. 

Creating a Record from the Query Based Tab   

When creating a record from the Query Based tab of another BP (that auto-populates data to the 
record being created), the Data Element (DE) of type “SYS Numeric Query Based” Data 
Definition (any DE of this type) is not updated, unless the user manually changes the trigger 
element. 
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Attaching Files 

This section outlines the rules for attaching files in Unifier. 

Assuming that you have the proper permissions, you may attach files (such as Word documents, 
spreadsheets, drawings, etc.) to business process forms, cells (such as a cost sheet or funding 
sheet), and Mailbox messages. These files can be uploaded and attached from your local 
system, or they can be attached from documents already uploaded and stored in the Document 
Manager. 

The file attachment procedures are similar across Unifier. When an Attach button is available in 
a Unifier window, it is associated with the ability to attach a file. When attaching files to other 
Unifier modules, such as a Mailbox message or Cost Sheet cell, you will be presented with two 
options: 

 My Computer: To attach a file from your local system. 

 Primavera Unifier Folder: To attach documents from the Document Manager. The window 
opens, displaying the Documents files and folders. Select the files and folders to attach and 
click OK. (Folders are not attached; the contents of selected folders are attached in a flat list. 
Documents with duplicate files names will not attach.) You must have at least view 
permission to the folders and files within the Document Manager in order to view and attach 
them. 

 Document Manager: Stores documents in Unifier’s powerful document management 
system. Files are uploaded to the DM and stored in a folder system. Access permissions can 
be applied to individual folders and documents. Files and folders are uploaded by clicking 
the Upload button. 

 Business Process Forms: If you are creating or participating in a business process 
workflow, you can add attachments to the form or to a general comment associated with the 
form. Document type BP forms have special file attachment functionality. You can access 
the attachments in Workflow task emails under General comments section in the Document 
type BP. 

Note: The Enable response via email option must be selected. 

 Cost Sheet, Funding Sheet, Schedule Sheet Cells: You can add a file attachment to cost 
sheet, funding sheet, or schedule sheet (or most any Primavera Unifier sheet) cells that have 
not been auto-populated from a business process. Open the cost, funding, or schedule sheet 
and click a cell. The Cell Detail window opens. In the Cell Detail window, click Attach. 

 Mailbox Messages: You can attach a file to a Mailbox message. Open a Mailbox message 
window and click Attach. 

Attaching Files From your Local System ("My Computer") 

To attach documents from your local system (general procedure), click the Attach button, 
choose My Computer and follow the prompts. 

Attaching Files From the Document Manager ("Primavera Unifier Folder") 

You can attach documents from Unifier Document Manager as long as you have at least view 
permission on the documents. 
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Attaching Documents From the Document Manager (General Procedure) 

1) Click the Attach button. 

2) Choose Primavera Unifier Folder. The Select Files window opens. 

This window displays the folder structure in the project or shell Documents node in the 
Document Manager. Here you can: 

 Open folders to view contents.  

 Select multiple documents or folders to attach.  

All documents within folders and subfolders will be attached in a flat file.  

Documents with duplicate files names will not attach. 

Attaching Files (Standard View) 

This topic outlines the rules for attaching files in Unifier. 

Assuming that you have the proper permissions, you may attach files (such as Word documents, 
spreadsheets, PDFs, etc.) to business process forms, cells (such as a Cost Sheet), and Mailbox
messages. These files can be uploaded and attached from your local system, or they can be 
attached from documents that were already uploaded and stored in the Document Manager. 

The file attachment procedures are similar across Unifier. When an Attach Files option is 
available in a Unifier window, it is associated with the ability to attach a file. When attaching files 
to other Unifier modules, such as a Mailbox message or a Cost Sheet shell, you are presented 
with two options: 

 Browse 

 Document Manager 

Browse Option for File Attachments 

If you select the Browse option, then a new Upload Files window is displayed. You can browse 
your local system for attachments by clicking on the Browse option in the top left corner of the 
window. In the middle portion of the window, there is a File log that contains the following 
columns: 

 File Name 

 File Size 

 Document Title 

 Rev. No. 

 Issue Date 

In the Advanced Options portion of the window, you are provided with options that pertain to 
the uploading process. You can select two checkboxes, which are Include reference files and 
Revise automatically if file with same name exists. However, unless you have more than one 
file with the same name, the Revise automatically if file with same name exists checkbox 
cannot be selected. If you select the Include reference files checkbox, then a drop-down list is 
available. You can choose whether to upload the files from your computer, auto-resolve the files 
from Documents as Dynamic Links, or auto-resolve the files from Documents as Static 
Links. 
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Once you select files to upload, click on the Upload option in the bottom right corner of the 
window. To close the window, click on the Cancel option. 

Document Manager Option for File Attachments 

If you select the Document Manager option, then a new Select Files window is displayed. You 
can browse a variety of existing folders from the Document Manager by clicking on any of the 
folders in the Project Documents log. This log contains the following columns: 

 Name 

 Comments 

 Location 

 Owner 

 Title 

 Rev. No. 

 Issue Date 

 Size 

In the top left corner of the window under the locator links, you can select the Search and Find 
on Page options. With the Search option, a new window is displayed where you can search for 
a file based on a variety of pre-determined conditions. You can also add conditions as well as 
match your search with any or all conditions. Once you have entered information into the 
Search bar, you can select the Search option to begin the search process. To go back to the 
previous window, select Reset.  

With the Find on Page option, you can search for a file or folder within the Project Documents
log. A new row is created at the top of the log, and this row contains search fields for each 
column. Upon entering information into the search fields, any matching results are highlighted 
and displayed in the log. To restore the log to its original state, clear the search fields by deleting 
the entered information. 

 Notes: 

 Folders cannot be selected and documents with duplicate file names 
cannot be attached. 

 You must have at least view permission to the folders and files within 
the Document Manager in order to view and attach them. 

Once you select the files, click on the Select option in the bottom right corner of the window. To 
close the window, click on the Cancel option. 

If you are creating or participating in a business process workflow, you can add attachments to a 
business process form or to a general comment associated with the form. Document-type 
business process forms have special file attachment functionality. You can add attachments to a 
general comment by selecting the Attach Files option in the Comments tab of a document-type 
business process form. The previous Browse and Document Manager options are available. 

When attaching files to a business process form, you may be presented with the previous two 
options as well as an additional option: 

 Browse 

 Document Manager 
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 Custom Print 

Custom Print Option for File Attachments 

If you select the Custom Print option, then a new Print window is displayed. The window 
contains two sections, Custom Print Template and Template and Format. In the Custom 
Print Template section, there is a Title heading followed by a text box that displays the specific 
Custom Print Template data. In the Template and Format section, there is a Name textbox 
along with Template and Format drop-down lists. 

 Notes: 

 A value must be entered into the Name textbox before proceeding. 

 If there are no Custom Print Templates available for the business 
process, then most of the elements of the window cannot be 
selected. The exception to this behavior is the Name textbox. 

Once you select Custom Print Templates to attach, click on the Attach option in the bottom 
right corner of the window. To close the window, click on the Cancel option. 

Adding Images 

In many forms, you can add an image to a business process, project, shell, etc. For example, 
you can add an image that shows progress on the project information record, pictures of assets 
related to a specific asset record, or a photo of an employee in the Resource Manager. You can 
add images to attribute forms in shells, projects, companies, and BPs. 

If the Image picker functionality has been added to your project in uDesigner, forms with the 
functionality display the image name and a virtual box that will hold the uploaded image. 

Note: The image name is based on the data element name provided in 
uDesigner. 

To add an image to a form: 

1) Click Upload Images in the toolbar at the top of the form. 

2) Browse for the image to upload and click OK. 

Valid image file types are: 

 .jpg 

 .jpeg 

 .gif 

 .png 

 .tif 

You can change the image by replacing it with another uploaded image. Images display on the 
HTML or PDF formats of printed forms. They display in print preview as well. The Image picker 
can be added to all forms except for those in the Cost Manager, Generic Cost Manager, 
Schedule Manager, and the Document Manager. 
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Adding Hyperlinks 

In many forms, you can add a hyperlink to a business process form, project, shell, etc. For 
example, you can add a hyperlink to equipment documentation, details on a resource, or 
external websites that contain information pertinent to a business process record. You can add 
hyperlinks to attribute forms in shells, projects, companies, and business processes. 

If the Hyperlink picker functionality has been added to your project in uDesigner, forms with the 
functionality display a hyperlink name, such as vendor website or internal web page. 

To add a hyperlink: 

1) Click on the hyperlink area on the form.The Hyperlink window displays: 

2) Enter the hyperlink name and the URL. Only the URL is mandatory. If you enter the name 
and the URL, the hyperlink displays as the name you entered. If you enter the URL only, the 
hyperlink displays as the URL. The protocols HTTP and HTTPS are the only protocols 
allowed. FTP is not supported for hyperlink creation on forms. 

Note: The URL should not reference the same domain that Unifier is 
using for operation (ask your site administrator if you do not know your 
domain name. If you attempt to use the same domain, a warning 
message will result. 

3) Click OK. 

To reset a hyperlink: 

1) Click on the hyperlink area on the form. The Hyperlink window displays. 

2) In the Hyperlink window, click Clear. This will remove the existing hyperlink. 

3) Enter a new hyperlink name and URL. 

4) Click OK. 

CSV File 

A Comma-Separated Values (CSV) data file, or a CSV template file, enables you to import or 
export data to and from Unifier. Each row in a CSV file corresponds to a new record and each 
column is a field to be populated on the form. For more information about importing and 
exporting a CSV template, see the "Importing Data from an Outside Data Source into Unifier" 
section.  

Note: CSV support all data definitions. 

As an example for how the data is updated by way of a CSV file, the following explains how the 
data definition type of "Company Picker" (for example, a contractor's name) is updated in the 
CSV template. The update is applicable to both upper form and detail form data elements of the 
Company Picker type. 

Project-level business process
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When Company Picker exists in a project-level business process, Unifier checks to ensure 
that the value you had entered in the Company Picker field of the CSV template is an active 
and valid company, or not. The valid values for the Company Picker are: 

 Owner company 

 Member companies in the shell 

Company-level business process

When Company Picker exists in a project-level business process, Unifier checks to ensure 
that the value you had entered in the Company Picker field of the CSV template is an active 
and valid company, or not. The valid values for the Company Picker are: 

 Owner company 

 All active partner companies 

Note: In both cases (project and company), if the CSV template contains 
an invalid value, then Unifier displays a message indicating that the 
company name is not a valid value for the selected data element. 

Exporting a CSV File 

When exporting a CSV template, the column headers display according to your Preferences 
settings. The following provides additional information:  

 If you enter data for any text type DE, the data is not translated. Example: "Vendor Specialty" 
is a text type DE. If the User enters "Electrical Appliances" as the data, then the entry is not 
translated according to the Preferences settings. 

 You must not include currency and digit grouping symbols when you enter data because the 
information is captured as a part of header information and according to your User 
Preferences settings. If you enter currency and digit grouping symbols when you enter data, 
you receive an error message. 

 Ensure that you enter the negative number format with a minus sign at the beginning of the 
number: Example: -10000,99 (minus 10000 comma 99). The decimal symbol is a comma) 

 If you enter a value in the date field, or in line items, through CSV, the values display 
according to your User Preferences settings. 

Notes: 

 All error messages, system, custom, or form validation, display 
according to your Preferences settings. 

 The file name of an exported file will not be translated automatically. 

The following lists the impacted modules: 

 CSV Import for all Business Processes for record creation 

 CSV Import for Asset Manager Objects for record creation 

 CSV Import under CM – Code and Record based manager for record creation 

 CSV Import under Planning Manager for record creation 

 CSV Import under Portfolio Manager for record creation 

 CSV Import under Shell Manager for record creation 
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 CSV Import under Space Manager for record creation 

 CSV Import under User Administration for record creation 

 Line Item import for Line Item creation 

Exporting a CSV File with or without an Import 

When you export a CSV data file from the sheet, the numeric fields display according to your 
Preferences settings (the number format options settings). The following provides additional 
information:  

 In Unifier functionalities that allow export and import of data through a CSV file, the currency 
symbol and digit grouping symbol are not displayed. 

 In Unifier functionalities that allow only exporting of data but not importing data through a 
CSV file, the currency symbol and the digit grouping symbol are displayed. 

 In Unifier functionalities that allow only exporting of data but not importing data through a 
CSV file, the negative numbers display according to your Preferences settings. 

 Decimal symbol display according to your Preferences settings. 

 In Unifier functionalities, which allow exporting and importing of data through a CSV, the 
negative numbers, if any, displays as: -<Number, Decimal Symbol, Number> (Example: 
-100000,99 – The decimal symbol is comma) 

 If there are any date fields, then the dates are formatted based on your Preferences 
settings. 

Importing a CSV Template Data File 

If importing a CSV data file (Example: Importing Column details), the column data appears 
according to your Preferences settings.  

 You do not need to enter the Currency symbol manually because the symbol is included in 
the header. Entering the Currency symbol manually generates and error message. 

 When importing a CSV file is complete, the number formatting displays according to your 
Preferences settings. 

 When importing a CSV file is complete, the date formatting displays according to your 
Preferences settings. 

 Oracle recommends that you use custom data elements for defining queries for a data picker 
filter condition. You can use the auto-populate in order to get the shell name or other shell 
properties populated on the record for the required custom data element.  

Note: Oracle recommends that you use custom data elements for 
defining queries for a data picker filter condition. You can use the 
auto-populate in order to get the shell name, or other shell properties, to 
get populated on the record for the required custom data element.  

List of Impacted Sheets and Modules 

The following is a list of impacted sheets and modules:  

 Cost Sheet  

 Funding Sheet 
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 CM sheet 

 Generic Cost Sheet 

 Planning Sheet 

 Summary Fund Sheet 

 Summary Budget 

 CBS Details 

 Column Details 

 Data Definitions (DDs) export  

List of Modules Only Impacted by Exporting 

In Unifier functionalities that allow only exporting of data but not importing data through a CSV 
file, the column headers and the Data Element (DE) labels display according to your 
Preferences settings. The following shows a list of modules impacted by exporting, only:  

 Basic data definitions under Data Structure Setup 

 Cost Codes under Data Structure Setup 

 Data Elements under Data Structure Setup 

 Data Picker under Data Structure Setup 

Importing Data from an Outside Data Source into Unifier 

The Unifier integration feature imports data into Unifier from an outside data source. Using this 
feature, you can import data from an outside application, such as an accounting system, into 
Unifier, and thereby, create records and line items. Importing is most effective in cases where 
you want to populate Unifier with a large amount of information that already exists in the other 
system. 

This section discusses importing data into Unifier using CSV files. You can use CSV files to 
create records and line items for business processes and most of the Unifier managers. It is 
largely useful for transferring a company’s legacy data to Unifier. 

Once you have edited and saved the CSV file, you can import it back into Unifier to create the 
new records or line items. During the import process, Unifier validates the data. If the data 
passes validation, the new records or line items will be created. If the data fails the validation, 
you can view or download a text file summarizing the errors. 

To use this feature, the business process or manager must include an integration interface that 
was designed in uDesigner. Separate integration interfaces are designed for each BP or 
manager, each specifying what fields will be populated when the new records or line items are 
created. 

Note: New records can also be created by XML integration via Web 
Services. For more information about Web Services integration, refer to 
the Unifier Integration Interface Guide. XML integration via Web Services 
must be coordinated with Primavera Unifier Consulting Services. 

The integration interface feature supports: 
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 Cost BPs 

 Line Item BPs 

 Simple BPs 

 Text BPs 

 Document BPs 

 Asset Manager classes 

 Code-and-record-based configurable manager classes 

 Planning Manager planning items 

 Shell Manager shells 

 Shell creation BPs 

Overall Steps for Importing Data 

Here is an overview of the steps involved in importing data from CSV files to create new records 
and line items. 

1) Export the CSV template file to your machine.

The CSV file contains the correct integration structure, with each row corresponding to a new 
record, and each column a field to be populated on the form. 

2) Modify the CSV file. 

Add new record data into the template CSV file, one record per row. 

3) Import the modified CSV file.

After completing the CSV file, you can then import it back into Unifier to create the new 
records or line items. During the import process, Unifier validates the data. If the data passes 
validation, the new records or line items will be created. If the data fails the validation, you 
can view or download the CSV file with the error summary. 

Note: The import process runs in background, allowing you to continue 
your work during the import and validation process. The amount of 
records being imported will affect the processing time. You will be 
notified by email once the process is complete and the records have 
been imported or errors have occurred. 

Exporting the CSV Template to Your Machine (Integration) 

To export an integration template: 

1) Display the toolbar with the Export button using the table below. 

2) Click the Export Template button and choose CSV. 

3) Save the CSV file to your local drive. 

To display the toolbar 
for this: 

Do this: 

A business process 
Select the name of the BP wherever it resides in the Navigator: 
in the Company Logs node, the General log node, or Data 
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To display the toolbar 
for this: 

Do this: 

at the company level Manager log node. 

A business process 
at the project/shell 
level 

Select the name of the BP wherever it resides in the Navigator: 
in the Project Logs node, the Information > General log node, or 
the Data Manager log node. 

An asset class 
In the Asset Manager node of the Navigator, select the asset 
class. 

A planning item 
In the Planning Manager node of the Navigator, select the 
planning item. 

A class for a 
code-and-record-bas
ed configurable 
manager 

In the [Manager] node of the Navigator, select the class. 

Editing the CSV File 

Each row in a CSV file corresponds to a new record, and each column is a field to be populated 
on the form. 

Note: Do not add, move, or delete the columns in the CSV file. 

To edit the CSV file: 

1) Open the CSV file in Microsoft Excel or a compatible application, such as a text editor or 
Notepad. 

2) To add header (upper form) data to the file: 
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a. Move your cursor to an empty line and type an H in column A. 

b. Press the Tab key to move to the next column and enter the value that you want to import 
for that field. 

c. Repeat step b for all the fields in the row. 

3) To add detail form data to the file: 

a. Move your cursor to an empty line and type a D in column A. 

b. Press the Tab key to move to the next column and enter the value that you want to import 
for that field. 

c. Repeat step b for all the fields in the row. 

4) If you have additional line item data that needs to be imported, repeat step 3 and its 
sub-steps until you have entered all the line items you want to import. 

5) Save the file. 

Importing CSV File into Unifier 

Once you have edited and saved the CSV file, you can import it back into Unifier to create the 
new records or line items. During the import process, Unifier validates the data. If the data 
passes validation, the new records or line items will be created. If the data fails the validation, 
you can view or download a text file summarizing the errors. 

To import the file into Unifier: 

1) Display the toolbar with the Import button as shown in the table below. 

2) Click the Import button. The File Upload window opens. 

3) Fill in the fields on the File Upload window and click OK. 

Unifier checks the import process to verify that valid records were created. Specifically, it 
validates that: 

 The import file format matches the integration interface design that was created in 
uDesigner. 

 The imported data is for the correct BP (that is, that the data was imported into the same 
log as that from which you exported the CSV template file). 

 The imported data is correct; that required fields contain data in the correct format, the 
data type is correct, the correct values were added for drop-down lists, etc. 

To display the toolbar for this: Do this: 

A business process at the company level 

Select the name of the BP wherever it 
resides in the Navigator:in the Company 
Logs node, the General log node, or Data 
Manager log node. 

A business process at the project/shell 
level 

Select the name of the BP wherever it 
resides in the Navigator:in the Project Logs 
node, the Information > General log node, or 
the Data Manager log node. 

An asset class 
In the Asset Manager node of the Navigator, 
select the asset class. 
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A planning item 
In the Planning Manager node of the 
Navigator, select the planning item. 

A class for a code-and-record-based 
configurable manager 

In the [Manager] node of the Navigator, 
select the class. 

Using CSV File to Import Attachments 

You can use a CSV template file to import attachments into Unifier, when you are creating a BP 
Record, or Line Item. 

Example 

There are 20 line items in a single record (Line Item type BP) and each line has an 
attachment. You can use a CSV template to include the names of all the attachments (for 
that single record) and import, or upload, all the attachments into Unifier. 

Note: For details on how to import a CSV file back into Unifier, see the 
previous topic. 

The last column of the CSV template is a placeholder for the file names of the attachment (the 
file that you want to attach to the BP Record, or Line Item). If you have more than one file to 
attach, you can enter the names of each attachment separated by a colon (:), for example, 
Attachment1.pdf:Attachment2.pdf:Attachment3.pdf. 

If you enter the same name in the Attachment cell twice, then Unifier ignores the duplicate and 
uploads a single file, only. 

If there is no data in the placeholder column of the CSV template file that is getting uploaded, 
then Unifier processes the CSV template upload as a file without any attachment. 

If you keep two attachments with the same name in the CSV file, then Unifier attaches the same 
two attachments to all the Item Lines referencing that name. 

If you upload a file twice, then Unifier overwrites the attachment that is present in the review 
section. 

The Attachment section of the CSV upload wizard lists attachments that are ready for upload 
(Ready to be uploaded). As you keep uploading the attachments on the Attachment section, the 
status of the files keep changing to Ready to be uploaded. 

Note: For security, the Company Administrators can specify the list and 
size of files that can be uploaded to the Company Properties page, by 
users and per company policy. Contact your Company Administrator for 
more information. 

Upload CSV and Add Attachments 

When the Upload CSV wizard opens, you can select the file manually (Add) or choose to drag 
the file onto the page. After uploading the CSV file, click Next to go to the Add Attachments
page. 
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Note: After you upload the required files, the status of each file changes 
to Ready to be Uploaded. 

For BP Record import 

 Unifier does not check whether the file attachment is allowed (set on the integration form) for 
the BP Record, or not. 

 If there are files referenced in the Attachments column of the CSV file, but the files are not 
uploaded in the Add Attachments section, then Unifier provides two options: 

 Select OK if you want Unifier to ignore the files referenced in the Attachments column of 
the CSV file. Unifier creates the BP Record without the attachments. 

 Select Cancel to navigate back to the CSV file and upload the attachments. 

Note: Oracle recommends that the total number of line items included in 
the CSV file not to exceed five thousand (5000), for better performance. 

For Line Item import 

 Unifier does not check whether the file attachment is allowed (set on the integration form) for 
the Line Item, or not. 

 If the CSV file upload is restricted for the Line Items tab, then Unifier disables the Upload 
Attachments and you are able to upload the CSV file. 

 If there are files referenced in the Attachments column of the CSV file, but the files are not 
present in the Attachment upload, then Unifier provides two options: 

 Select OK if you want Unifier to ignore the files referenced in the Attachments column of 
the CSV file. Unifier creates the Line Item without the attachments. 

 Select Cancel to navigate back to the CSV file and upload the attachments. 

The CSV file attachment process starts when you click Upload, in the Add Attachments window. 
If there are any validation errors, Unifier displays a pop-up window after you click Next on the 
Upload CSV page window. 

For Document-type BP 

 Unifier processes the attachments referred to at the Line Item level (D level in the CSV file), 
only.  

 If you reference an attachment at the BP Record level (H level in the CSV file), Unifier 
ignores the attachment that is available on the Attachments window of the CSV upload 
wizard. 

For Text-type BP 

 Unifier ignores all attachments included in the CSV file and the attachments do not appear 
on the Attachments window of the CSV upload wizard. 

Blocked file extension 

Unifier prevents uploading of file attachments with blocked extensions, as configured by your 
Site Administrator (System Administrator). 
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Audit log 

 If a CSV import of a BP record occurs, if an attachment is uploaded during creation, then the 
system does not audit the attachment.  

 If a CSV import of a Line Item occurs, the system does not audit the attachment.  

Internationalization and CSV Files 

Importing and exporting data in Unifier can be done by using a Comma-Separated Values (CSV) 
data file or a CSV template file. This section explains how the availability of different languages 
(Internationalization) impact the various CSV files created, used, imported, or exported. 

Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 

Generic CSV files 

Language preferences are detected from the Preferences settings (Region Format), for both 
CSV data files and CSV template in: 

 All column headers 

 All informational text 

If importing a CSV file fails, the import error file displays the system generated error messages in 
the preferred language.  

If importing a CSV file fails because of form validation errors, then the custom error message 
displays the message in the preferred language. 

Notes: 

 If translation is not available for a custom error message, then the 
source string is displayed. 

 Before importing a CSV file, always check the Preferences settings 
to see the allowed format and number formatting. 

 When importing, or exporting, a CSV file, the date format follows the 
Preferences window (Region Format) Date Format settings. 

Additional information about exporting and importing CSV files 

When importing and exporting of a CSV file is conducted by users with two different language 
settings (for example, French and German), the data entered into an exported file must match 
the original language set. 

Example 

The CSV template Export has been done in French and the template is being used by a 
German User. If the German User enters data without changing the column structure and 
Import the file, the Import action will fail and an error message will appear in German, 
indicating the error. 
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Internationalization and Web Services 

About Web Services

New records can be created and line items added using Integration through Web Services. Also, 
the Unifier Schedule Manager integrates with Primavera scheduling software by way of Web 
Services.  

Note: Integration through Web Services must be coordinated with an 
Oracle Primavera representative. 

As Project Administrator, you can receive email notification of the successful creation of a shell 
instance, for shells that are created manually, through Web Services or a CSV file upload, or 
through auto-creation. This notification can be set up in email notifications in uDesigner. Also, 
you can set your Preferences to control whether you receive these notifications. 

Refer to the Unifier Reference Guide for data elements you can use with Web Services. 

Web Services and Internationalization 

The output data generated by Web Services is always in the source language. 

Note: If a record (Example: Business Process) is created by using Web 
Services and the Data Definition (DD) label includes a non-ASCII string, 
then the record creation will fail. 

Number formatting of data 

When you enter numeric data in XML, you can use the decimal point (period) and negative sign 
(dash), only. 

Examples 

XML Tag: <Committed_Amount>100.99</Committed_Amount> 

XML Tag: <Credited_Amount>-1423.99</Credited_Amount> 

Get Web Services 

You can use the Get Web Services call methods to get various attributes of Shell, CBS, and the 
list of Business Process records, Shells, and User defined data. 

When you run a Get call, the input content in the response XML will be in the language of the 
source strings. 

Number formatting does not apply to the numeric data and the decimal point is a period. The 
negative numbers are displayed with the minus sign before the numeric data, for example, 
-12345.99. 

Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 
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Searching and Finding in Unifier 

You can use the Search and the Find on Page options to search for specific items in: 

 Business Processes 

 Manager sheets 

 Pickers 

You can also use the Search and the Find on Page options to search for a design in uDesigner. 

When you use the Search and the Find on Page options, Unifier narrows the list of items shown 
on a sheet, or picker, to match the search criteria you specified. 

The Search and the Find on Page options show fields from the sheets, or pickers, that you can 
use to narrow the list of items you see. For example, for pickers with extensive lists, this can 
make completing the business process form much quicker. 

The fields that appear in the Search and the Find on Page options are usually specified in 
uDesigner when the forms are designed for the business processes, managers, and pickers. 

Note: Some logs, such as the Mail logs, use "canned" Search and Find 
on Page windows because these logs are not designed in uDesigner. 

In This Section: 

Searching and Finding: Search Option 

Searching and Finding: Find on Page Option 



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Searching and Finding: Search Option 

The Search option enables you to search specific elements of a BP, sheet, picker, etc. Upon 
clicking the Search icon in the toolbar menu of a BP, sheet, or a picker, the Search window is 
displayed. You can move the window around the right pane in a horizontal or a vertical motion 
depending on if the window is docked at the bottom or to the right. The Dock Right/Dock 
Bottom option allows you to adjust the positioning of the window. 

This Search window contains advanced search features that change depending on the function 
that you are working in. Unlike the Find window in Classic View, the Search window does not 
have a Save option that allows you to save your search. When you modify the previous search 
fields, you can click the Apply option to save those modifications. The Clear option resets the 
search fields back to their default values. 

Similar to the previous Find window, the search fields often contain changeable operators, like 
“contains” or “equals,” which you can use to further specify the items you want to see. 

Like Classic View, some of the search fields contain Select dropdown lists where you can 
choose from a list of values. Some of these lists allow you to select multiple values as you click 
the items. If you select multiple values, then the search will contain results that match any or all 
of the values that you selected. 

Searching and Finding: Find on Page Option 

The Find on Page option enables you to find specific elements of a BP, sheet, picker, etc. Upon 
clicking the Find on Page icon in the toolbar menu of a BP, sheet, or a picker, a new row is 
created within the log. Unlike the Search option, the Find on Page row appears at the top of the 
log and therefore cannot be moved. 

This Find on Page row contains search fields that change depending on the function that you 
are working in. Unlike the previous Find window in Classic View, The Find on Page row does 
not have a Search option that initiates the searching process. Instead, the searching process 
begins immediately upon entering information into the search fields in the row.  

Unlike the previous Find window, the search fields do not have changeable operators, like 
“contains” or “equals.” Similar to the Search option, Find on Page also does not have a Save 
option that allows you to save your search. 

When you enter information into the search fields, any matching results are highlighted and 
displayed in the log. To restore the log to its original state, clear the search fields by deleting the 
entered information. 
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Searching and Finding a Shell 

Since shell hierarchies can be extensive, you can use the Find ( ) feature to locate 
specific shells. 

You can search for a shell by using either the Geocode parameters or the Form parameters but 
not both. 

To search for a shell by using the Geocode parameters: 

1) Go to the shell (anchor shell) that contains the shell you want to find. 

2) From the right-hand pane, which displays the shell dashboard, go to the last pane (mini log) 
at the bottom of the page. 

3) Click Find ( ) to open the Find window. 

4) Enter values in the fields under the Geocode section. 

Select either an address or a latitude and longitude. 

 In the Address equals field, enter a full or partial address for the shell, or 

 In the Latitude equals and Longitude equals fields, enter the values, if you know them. 

If you do not know the longitude and latitude, select the Longitude equals field, click the 

globe  icon beside the Latitude equals field to open the Geocode (Latitude/Longitude) 
Picker window. 

 Select the Enter Address field and enter the address, or a partial address. 

 (Optional) To see the location on the map, click Map It. Unifier fills in the decimal degrees 
for the latitude and longitude, as well as the degrees, minutes, and seconds. 

 Click OK. Primavera Unifier will fill in the Latitude equals and Longitude equals fields 
on the Find window. 

 Back in the Find window, in the Radius less than or equals field, enter a value to 
specify a search radius surrounding the address or longitude/latitude coordinates. 

5) When finished, click Search. 

6) When you finished finding the shell, click the Restore button to return the dashboard to 
normal view. 

To search for a shell by using the Form parameters: 

1) Go to the shell (anchor shell) that contains the shell you want to find. 

2) From the right-hand pane, which displays the shell dashboard, go to the last pane (mini log) 
at the bottom of the page. 
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3) Click Find ( ) to open the Find window. 

4) Enter values in the fields under the Form section. 

For all the fields in the Form section, you can change the "contains" and "equals" values to: 
does not contain, equals, does not equal, is empty, and is not empty, respectively. 

5) When finished entering values, click Search. 

6) When you finished finding the shell, click the Restore button to return the dashboard to 
normal view. 
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Searching and Finding a Shell (Standard View) 

Since shell hierarchies can be extensive, you can use the Search option to locate specific 
shells. 

You can search for a shell by using either the Geocode Search parameters or the Shell
parameters. 

To search for a shell by using the Geocode Search parameters: 

1) Go to the anchor shell (All Projects) that contains the shell you want to find. 

2) From the right-hand pane, which displays the shell dashboard, select the My Dashboard 
option. 

3) In the All Projects log, select the Search option to open the Search window. 

4) Enter values in the fields under the Geocode Search section. 

Select an address or a latitude and longitude. 

 In the Address field, enter a full or partial address for the shell. 

 In the Latitude and Longitude fields, enter the values, if you know them. 

If you do not know the latitude and longitude, then you can select the View Map option to 
open the Geocode (Latitude/Longitude) Picker window. 

 Select the Address, City, State, Country, Postal Code field and enter a full or partial 
address. 

 To see the location on the map displayed in the window, you can select the Map It
option. Unifier fills in the Decimal Degrees for the latitude and longitude as well as the 
Degrees, Minutes, and Seconds. The Map It option is also available for Decimal 
Degrees and Degrees, Minutes, and Seconds. To clear the fields, select the Clear
option. 

 Click on the Done option to go back to the previous Search window. Unifier fills in the 
Latitude and Longitude fields in the Search window. 

 In the Search window, you can enter a value in the Radius field to specify a search 
radius surrounding the address or latitude and longitude coordinates. 

5) When finished, select the Apply option in the top right corner of the window. 

6) To reset the search fields back to their default values, select the Clear option. 

To search for a shell by using the Shell parameters: 

1) Go to the anchor shell (All Projects) that contains the shell you want to find. 

2) From the right-hand pane, which displays the shell dashboard, select the My Dashboard
option. 

3) In the All Projects log, select the Search option to open the Search window. 

4) Enter values in the fields under the Shell section. 

For the Administrator, Location, Project Number, and Project Name fields, you can 
change the Contains and Equals values to: Does Not Contain, Does Not Equal, Is Empty, 
or Is Not Empty. For the Project Type and Status fields, you can change the Equals values 
to: Does Not Equal, Is Empty, or Is Not Empty. 

5) When finished, select the Apply option in the top right corner of the window. 

6) To reset the search fields back to their default values, select the Clear option. 
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Searching in Managers Logs 

Most manager logs, including Configurable Modules logs, display a static Find window 
(containing Search By and Search for fields) in order to enable you to find information. 

The Planning Manager displays a Searching and Finding: Search Option (on page 105) 
window which contains search criteria fields. 

The Document Manager and Shell work differently and are explained separately. See the 
following sections for details: 

 Searching and Finding a Shell (on page 106). 

 Searching in Document Manager Node (Standard View) (on page 109). 

In most manager logs, you will be searching for Sheets. In the following managers, you can 
search for additional objects: 

 In the Cost Manager log, you can search for earned value, general spends, and payment 
applications. 

 In the Resource Manager log, you can search for resources or (if you are in administration 
mode) roles. 

 In the Schedule Manager, you can search for custom calendars. 

To search in most manager logs: 

1) Go to the Company Workspace tab, or open the Project/Shell where the manager resides. 

2) In the left Navigator, click the manager node you want to search. The manager expands to 
list sub-nodes. 

3) If there are sub-nodes in the Navigator, click the sub-node you want to search. 

4) Click the Find button in the toolbar. 

Unifier displays a Find window above the right pane. The window will display different fields, 
depending on how the manager has been designed. 

5) Enter your search criteria and click Search (or press Enter on your keyboard). Unifier 
displays all the items that meet the search criteria you entered. 

Searching in Document Manager Node (Standard View) 

This section consists of the following topics: 

 Searching in Document Manager Sub-Nodes 

 Supported Documents 

 Indexing and Content Search 

 Document Index Migration 
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Searching in Document Manager Sub-Nodes 

You can access the Document Manager node from: 

 Project (User mode) 

 Company Workspace (User mode) 

In the project (User mode), the Document Manager node contains the following sub-nodes: 

 Documents 

 Recycle Bin 

 Unpublished Documents 

In the Company Workspace (User mode), the Document Manager node contains the following 
sub-nodes: 

 Company Documents 

 Recycle Bin 

 Unpublished Documents 
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The following applies to the search and find features in both project and Company Workspace 
Document Manager sub-nodes. 

Search 

The Search window enables you to search for document properties or contents. 

1) Click to expand the Document Manager node in the project (User mode). 

2) Click Documents sub-node to display the Documents log. 

3) From the toolbar menu, click Search  to open the search window. The Search window 
enables you to search for document properties or contents. Some of the options are: 

 Content 

 Linked Records 

 Name 

 Title 

 Description 

Find on Page 

Use Find on Page to narrow your search in the records displayed within the log. 

1) Click to expand the Document Manager node in the project (User mode). 

2) Click Documents sub-node to display the Documents log. 

3) From the toolbar menu, click Find on Page  to open a new row in the table (log columns) 
within the Documents log. 

4) Enter values in the fields to narrow your search in the records displayed within the log. 

Supported Documents 

The following is a list of supported documents for content search: 

 Microsoft® Word Document (.doc/.docx) 

 Microsoft® Excel Document (.xls/.xlsx) 

 Microsoft® PowerPoint Document (.ppt/.pptx) 

 Microsoft® Project (.mpp) 

 Rich Text Format (.rtf) 

 Adobe Portable Document Format (.pdf) 

Note: Contents of PDF files created using Adobe LiveCycle Designer 
cannot be searched. 

 Hypertext Markup Language (.html) 

 Extensible HyperText Markup Language (.xhtml) 

 Plain Text files (.txt, .java, .bat, etc.) 
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 Document formats supported by Apache Tika 1.3 

Indexing and Content Search 

The following contains general information about indexing and content search in Unifier: 

Unifier uses Lucene StandardAnalyzer 2.9.3 to index and search the documents. 

The following contains examples, and a brief explanation, of how a document or phrase is 
indexed and searched in Unifier: 

 If a document contains the sentence "The quick brown fox jumped over the lazy dog," it will 
be stored in index using the tokens: [quick] [brown] [fox] [jumped] [over] [lazy] [dog]. When 
you search for the string, "fox," the document will be found.  

 If a document contains the sentence "server.local.port=7001," it will be stored in index using 
the tokens: [server.local.port] [7001], so if you search for the string, "server," the document 
will not be found. In this case, you must search for the string, "server.local.port" to get this 
document in the search results.  

The phrase "XY&Z Corporation - xyz@example.com" will be indexed as [xy&z] [corporation] 
[xyz@example.com]. 

In case of xml files, only the element content will be indexed. The tag and attribute value will not 
be indexed and cannot be searched. See the following example: 

<?xml version="1.0" encoding="UTF-8"?> 
<!-- in the project's Project Properties dialog box.--> 
<project name="Unifier913" default="default" basedir="."> 
    <description>Builds, tests, and runs the project Unifier913.</description>     
</project> 

In the example above, the xml file will be indexed as [builds] [tests] [runs] [project] [unifier913]. If 
you search for the string, "description," then the document will not be returned, but if you search 
for the string, "project," you will get the document since the string "project" is a part of the 
element content.  

The indexing background job is scheduled to run every 15 minutes. The documents added to 
Document Manager are available for search every 15 minutes after being added. 

Note: In the case of Unpublished documents, the attachments will be 
searched, only. The record information PDF will not be searched. 

Document Index Migration 

Once the server is restarted, the indexer job starts re-indexing for all of the documents to 
migrate the index from Lucene 2.9.3 to  Lucene 4.0 format. 

Note: The re-indexing job takes 2 to 3 days to complete, depending on 
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the number of files that need to be re-indexed. If you conduct a 
document search during the re-indexing job, you may receive an error 
message asking you to wait until the job is completed. 

Searching Date Fields 

The floating Find window provides comprehensive search criteria for date fields. If the date field 
on the Find window includes an operator, you may have the option of making the search 
relevant to today’s date. 

For example, for a date field, such as a Payment Due Date, you could specify that the value in 
the field should be greater than or equal to: 

Another example might be that the value in the field should be between: 
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Floating Find windows display search results that include a banner across the top of the window. 
This banner indicates that the list has been searched, or filtered. To restore the list of records to 
its unfiltered state, click Cancel Filter in the banner. 

Searching Mailbox Log, Notifications Log, and Sent Items Log (Home Page) 

The Mailbox node, in Home page, has the following sub-nodes:  

 Inbox

 Notifications

 Sent Items

Inbox 

To search the Inbox, click the Inbox sub-node and in the Inbox log click the View drop-down 
list. The View drop-down list enables you to search in the Inbox by adjusting the log view and 
using the following options: 

 Received in last 7 days 

 Received in last 30 days 

 Group by Origin 

 Group by From 

 All Items 

You can use the search icon (magnifying glass)  to open the Search screen and determine 
the values for the columns in the Inbox log by: 

 Field 

 Operator 

 Value 



Unifier General User Guide

116

The Search screen also enables you to determine the number of records that you want to be 
displayed on the Inbox log. 

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on 
the log. 

See the Home Page (on page 69) topic for more details. 

Notifications 

To search the Notifications, click the Notifications sub-node and in the Notifications log click 
the View drop-down list. The View drop-down list enables you to search in the Notifications by 
adjusting the log view and using the following options: 

 Received in last 7 days 

 Received in last 30 days 

 Group by Business Process 

 Group by Origin 

 All Notifications 

You can use the search icon (magnifying glass)  to open the Search screen and determine 
the values for the columns in the Inbox log by: 

 Field 

 Operator 

 Value 

The Search screen also enables you to determine the number of records that you want to be 
displayed on the Notifications log. 

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on 
the log, if you have permission to view. 

See the Home Page (on page 69) topic for more details. 

Sent Items 

To search the Sent Items, click the Sent Items sub-node and in the Sent Items log click the 
View drop-down list. The View drop-down list enables you to search in the Sent Items by 
adjusting the log view and using the following options: 

 Sent in last 7 days 

 Sent in last 30 days 

 Group by Origin 

 Group by To 

 All Items 

You can use the search icon (magnifying glass)  to open the Search screen and determine 
the values for the columns in the Inbox log by: 

 Field 

 Operator 

 Value 
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The Search screen also enables you to determine the number of records that you want to be 
displayed on the Sent Items log. 

The right hand side, next to the Inbox log, shows the contents of the email that is highlighted on 
the log. 

See the Home Page (on page 69) topic for more details. 

Searching Sheets 

For all manager sheets except the Cost Manager Cost Sheet, searching for items entails 
searching a specific column on the sheet for a value. Unifier searches the line items in that 
column and highlight the value, if found. 

To search a sheet: 

1) Open the sheet. 

2) Click the Find button (or choose Find from the View menu). A Find window opens. 

3) In the Column field, choose the column that contains the value you are looking for. 

4) In the Value field, enter the value you are searching for. 

You can enter a full or partial word, number or other value, but do not enter a wildcard 
character for partial entries. The format of your entry will depend on the type of value you are 
searching for. If you are searching for a fund code, you can include the code separator if one 
is used (for example, a dash). 

5) In the Search field, choose the direction in which you want to search, relevant to the location 
of your cursor on the sheet. Choose Up or Down. 

6) Click the Find Next button. 

If Primavera Unifier finds the value, it will highlight the row on the sheet. 

Search for cost codes on a Cost Manager Sheet: 

The Find feature on the Cost Manager Sheet works differently from other sheets. On Cost 
Manager Sheets, you will be looking for a cost code. 

To search for a cost code: 

1) In the Cost Sheet window, click the Find button. The Cost Code Find window opens. 

2) Select the cost code segment you want to search by. 

3) In the Cost Type field, select the cost type you are looking for. 

4) Click OK. 

Unifier displays the results in a separate cost sheet window. 
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Searching Pickers 

Most pickers include a Find feature with which you can locate specific objects (codes, assets, 
business processes, users, shells, etc.) while you are working on a form or a sheet . When you 
use this Find feature, Unifier narrows the list of items shown on the picker to match the search 
criteria you specified. For pickers with extensive lists, this can make completing the business 
process form much quicker. 

Some pickers display static Find windows; others display floating windows like the Task and 
business process logs (however, without the "save search" feature). 

For most pickers, the Find feature works as generally described under Searching and Finding: 
Search Option (on page 105) and Searching and Finding: Find on Page Option (on page 
105); however, the User/Group Picker works differently. 

Notes: 

 Fund Pickers are most often searchable by the fields that were 
created for the fund attribute form in uDesigner. However, if no 
attribute form was created for the fund, you can search for the fund 
by its name or code.  

 Pickers that include CBS codes display information generated from a 
sheet (the cost sheet or an SOV). Consequently, the Find feature on 
the CBS Picker, Commit Line Item Picker, and SOV Picker works the 
same way as it does on manager sheets. For instructions on using 
these pickers, see Searching Sheets (on page 117). 

To find a user in the User/Group Picker 

1) Open the User/Group Picker. 

2) The List Names from field shows the project/shell or company from which the users’ names 
will come. (This field is editable only by your company Administrator.) 

3) Use the Show By field to restrict the search to users only, to groups only, or to both. 

4) In the Search for field, enter a name, or partial name. 

5) Click Search or press Enter. 

Unifier uses the filters at the top of the Find window and searches the picker list according to 
the project/shell, or company specified in the List Names from field, as well as the Show By
option you specify (users, groups, or both). 

Unifier displays on the picker the names that met the search criteria you entered, and also 
displays above the list this line: Current View: <filtered by ...> [Cancel Filter]. 

Note: If you choose to, you can cancel the search action by clicking 
[Cancel Filter]. Unifier will restore the picker list. 

User/Group Picker and type-ahead

In the “To” or “Cc” fields (mail recipients) or in the Edit Permissions (log level) and other fields 
(where user and groups are both supported), when you enter a value Unifier includes both users 
and groups:  
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 If a user is displayed in the type-ahead, then the name is prefixed with the user’s profile. 

 If a group is displayed in the type-ahead, then the name is prefixed with the group icon. 

Example 

"Enter a <Display Element's column name> ..." 

In the unlikely case of display element not being present in the log, the placeholder text will 
be "Enter a <Display Element label>..." 

Internationalization 

The process of planning and implementing of the following Unifier services so that they can be 
adapted to specific local languages and cultures: 

The following topics explain the process of planning and implementing Unifier services so that 
they can be adapted to specific local languages. These services include: 

 Email notifications 

 Tools 

 BI Publisher Custom Reports 

 Dashboards 

 Help files 

 Spell check 

 Date and time zone formats 

 Audit log 

Internationalization (Email Notifications) 

When Unifier generates an email notification, the language used for that email is based on the 
recipient's in Preferences. 

Email notifications for scheduled User-Defined Reports (UDRs), Gates, and so forth, have two 
components: 

 Text 

 Attachments 

If a Business Process (BP) email notification contains an attachment with the record information, 
then the Custom Strings and number formatting in the attachment is according to the 
Preferences. 

If a scheduled UDR is sent as a part of an email attachment, the language in the PDF 
attachment is according to the Preferences of the UDR owner; however, the email text content 
is according to the recipient's User Preferences. 

When a UDR is generated manually and saved by a User, the language in the PDF attachment 
is according to the Preferences of the User who generated, or ran, the UDR. 

If a scheduled job such as Project Gates, where the "Auto-email as PDF attachment to users 
and groups" option is selected, the language in the PDF attachment is according to the User 
Preferences of the creator of the job (Project Gates creator). 
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When a manual refresh of the Gates is requested, the language in the PDF attachment is 
according to the Preferences of the User who requested the refresh. 

Internationalization (Support for Tools) 

When used within Unifier,the following tools support internationalization:  

 Oracle Map, AutoVue Server, Flex replacement (O charts) 

Note: The Unifier Plug-ins do not support internationalization. 

Oracle Map viewer supports internationalization for Tier 1 languages. Refer to the Oracle Map 
Viewer User Guide for more details. 

The language displayed in the map, and the following subsequent areas, is according to the 
language selected in the Preferences of the user: 

 View map for BP records from log 

 Shell Landing Page 

 Map Picker in Log Find 

 Map Picker in Bulk Edit 

 View Map when invoked from the BP record 

Note: eLocation services, which is used for geocoding, does not support 
internationalization. As a result, the map labels are displayed in English. 
If a User enters a label in a different language, then the Find feature 
does not provide the desired results. 

Internationalization (BI Publisher Custom Reports) 

The Oracle Business Intelligence Publisher (BI Publisher or BIP) Reports support 
internationalization as follows: 

Custom Report (Report File tab) window

If there are no templates available for the report,the Custom Report window (Report File tab) 
displays according to the default settings. 

To upload the translated XLIFF files and report layout, click Add to open the Add Template and 
Files window, enter data in the required fields, and click OK. 
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Notes: 

 The non-RTF templates do not support internationalization. 

 You can change the template type when the template is in Creation 
stage, only. Once you create a template, you cannot change the 
template type. Use the report designer to create a new template with 
the desired template type and remove the template that is no longer 
needed. 

In the Custom Report window (Report File tab), the only editable column is the Default column, 
which allows you to set the default template by selecting (check-box) the corresponding 
template. 

Note: The system sets the first template, or XLIFF file, that you upload 
as the default template. 

Use Modify in the Custom Report window (Report File tab) to modify an existing template. Once 
you click Modify, the Modify Template and Files window opens which allows you to modify the 
template and the translated XLIFF file for that template. When finished, click OK. 

Use Download in the Custom Report window (Report File tab) to download a template and the 
corresponding translated XLIFF file, in a zip file. 

External Data Model BI Publisher Reports

If you want to download the data model of a template, select the template and click Download in 
the Custom Report window (Report File tab). When the download is complete for an External 
BIP report, the data model is included. 

Non-RTF type template

BIP supports RTF templates and XLIFF files. If the report designer selects a non-RTF type 
template, the Browse option in the Modify Template and Files window (Translated XLIFF files for 
the Template section) will be disabled. 

Custom Report (Query tab) window

Queries based on Data Definition (DD) support internationalization and number formatting 
associated with internationalization according to the Preferences settings. 

Queries based on Data Views do not support internationalization and formatting because raw 
data is being used. 

Queries based on Ad-Hoc support internationalization and number formatting associated with 
internationalization according to the Preferences settings. 

Internationalization (Dashboards) 

Shell Dashboards

The Shell Dashboards support Internationalization and number formatting for System Strings as 
well as Custom Strings according to the Preferences settings. 

Custom Dashboards
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Custom Dashboards have two components: 

 Data cube 

 SWF file 

The SWF file uses the data cube and the labels are created when the user selects the Download 
XML option from the Custom Dashboard log and downloads the generated XML. The language 
used in the generated XML is based on the Preferences settings for both System Strings and 
Custom Strings. 

Note: If you change the language, you need to recreate the SWF (Small 
Web Format) file in order to generate a translated XML. If there are no 
caching of data in the Dashboard, the translation takes place, but if there 
caching of data in the Dashboard, then there will be no translation. 

Internationalization (Help Files) 

Unifier Help files do not support Internationalization and are not translated. 

Note: You can translate the Help files, using a third party translator, and 
display the files based on the your Preferences settings. This includes 
uploading a single PDF with multiple language help information. 

Internationalization (Spell Check) 

The Spell Check feature does not support Internationalization. 

Note: If the language selected in your Preferences is not English, the 
Spell Check option will not be available. 

Internationalization (Date and Time Zone Formats) 

Date formats

The following additional date formats support Internationalization: 

 MM/DD/YYYY 

 DD/MM/YYYY 

 MM/DD/YY 

 DD/MM/YY 

 MM-DD-YYYY 

 DD-MM-YYYY 

 MM-DD-YY 

 DD-MM-YY 

 DD.MM.YYYY 

 YYYY-MM-DD 
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 MMM/DD/YYYY 

 DD/MMM/YYYY 

 YYYY/MMM/DD 

 M/D/YYYY 

 M/D/YY 

 D/M/YYYY 

 D/M/YY 

 YY/M/D 

 YYYY/M/D 

 YY/MM/DD 

 YYYY/MM/DD 

Time Zone formats

The Time Zone setting is based on the Coordinated Universal Time (UTC) and support 
Internationalization.  

Note: The time format for all dates is: HH:MM AM. 

Internationalization (Audit Log) 

Within the Audit log, the following columns support Internationalization according to the 
Preferences: 

 Event 

 Description 

 Field 

For Event, Description, and Field columns, System Strings are and Custom Strings can be 
translated. 
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P6, Unifier, and Gateway 

Unifier uses the Rate Sheet object in Gateway, with canned fields, for connecting Rate Sheet 
with P6.  

A new OOTB Unifier Object, "Rate Sheet" (in Gateway) contains all of the canned fields present 
under the Master Rate Sheet in Unifier. See Unifier Master Rate Sheet. 
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Gateway Data Dictionary 

The following objects, in Gateway data dictionary, support the integration: 

 P6Resource

 P6ResourceRate

 P6Role

 P6RoleRate

Each of these objects are explained in the following tables: 

P6Resource

Note: P6Resource exists in Gateway only, and it is not deployed through 
Unifier. 

Field Type Description 

uuu_resc_parent_id String Resource Parent ID 

uuu_resc_short_name String Resource short name 

uuu_resc_name String Resource Name  

uuu_resc_status String Resource Status 

uuu_resc_curr String Currency 
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P6ResourceRate

Note: P6ResourceRate exists in Gateway only, and it is not deployed 
through Unifier. 

Field Type Description 

ResourceObjectId Foreign Key Resource object ID to map the rate 

effective_date String effective date for the rate 

standard_rate String price per unit 

P6Role

Note: P6Role exists in Gateway only, and it is not deployed through 
Unifier. 

 Field Type Description 

uuu_role_parent_id String Role Parent ID 

uuu_role_short_name String Role Code 

uuu_role_name String Role Name 

uuu_role_status String  Role Status 

P6RoleRate

Note: P6RoleRate exists in Gateway only, and it is not deployed through 
Unifier. 

Field  Type Description 

RoleObjectId Foreign Key Role object ID to map the rate 

standard_rate String price per unit 

Gateway Field Mappings 

The following out of the box (OOB) field mapping templates are in Gateway to support the 
integration: 
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Mapping 
Typ
e 

Flow 
Type 

Unifier Object 
Gateway 
Object 

P6 Object 

Sync Resource data from 
P6 for EVM 

Bot
h 

Master 
Data 

P6Resource 
(New) 

Resource Resource 

Create Resource Rate 
from P6 for EVM 

Cre
ate 

Master 
Data 

P6ResourceRat
e (New) 

Resource 
Rate 

Resource 
Rate 

Sync Role data from P6 
for EVM 

Bot
h 

Master 
Data 

P6Role (New) Role Role 

Create Role Rate from 
P6 for EVM 

Cre
ate 

Master 
Data 

P6RoleRate 
(New) 

Role Rate Role Rate 

Resource Data from P6 

A mapping template is created to map the fields of Resource object in P6 to P6Resource
object in Unifier. The following is used for creating/updating a new Rate Sheet in Unifier: 

Unifier Field Name Gateway Field Name P6 Field Name 

uuu_resc_parent_id ParentObjectId ParentObjectId 

uuu_resc_short_name  Id Id 

uuu_resc_name Name Name 

uuu_resc_status IsActive IsActive 

uuu_resc_curr CurrencyName CurrencyName 

Resource Rate from P6 

A mapping template is created to map the fields of Resource Rate object in P6 to 
P6ResourceRate object in Unifier. The following is used for creating/updating a new Rate Sheet 
in Unifier: 

Unifier Field Name Gateway Field Name P6 Field Name 

ResourceObjectId ResourceObjectId ResourceObjectId 

effective_date EffectiveDate EffectiveDate 



Unifier General User Guide

128

Unifier Field Name Gateway Field Name P6 Field Name 

standard_rate PricePerUnit PricePerUnit 

Role Data from P6 

A mapping template is created to map the fields of Roles object in P6 to P6Role object in 
Unifier. The following is used for creating/updating a new Rate Sheet in Unifier: 

Unifier Field Name Gateway Field Name P6 Field Name 

uuu_role_parent_id ParentObjectId ParentObjectId 

uuu_role_short_name Id Id 

uuu_role_name Name Name 

uuu_role_status IsActive IsActive 

Create Role Rate from P6 

A mapping template is created to map the fields of Role Rate object in P6 to P6RoleRate
object in Unifier. The following is used for creating a new Role in the Rate Sheet in Unifier: 

P6 Field Name Gateway Field Name P6 Field Name 

RoleObjectId RoleObjectId RoleObjectId 

standard_rate PricePerUnit PricePerUnit 

This mapping template contains the pre-defined elements of Unifier mapped to corresponding 
fields in P6, but you can deploy additional custom attributes to Gateway (for Activity Sheet), and 
they will be available for the data mapping templates. 

For mandatory fields, the integration will fail if you change the data mapping template (or create 
your own data mapping template) such that a mandatory element is no longer in the template 
(i.e., you remove a mandatory element from the mapping template). 

Note: The schedule type is a mandatory field while sending the data 
across multiple P6 projects to Unifier. 
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Business Flows in Gateway 

The following out of the box (OOB) Business Flows are available in Gateway: 

Business Flow Field Mapping Template 
(Applied for) 

Description 

Get Resource and Role 
Rates from P6 for EVM 

Sync Resource data from 
P6 for EVM (Both) 

Sync Resource Rate from 
P6 for EVM (Create) 

Sync Role data from P6 for 
EVM (Both) 

Sync Role Rate from P6 for 
EVM (Create) 

Create/Update Rate Sheets 
from P6 to Unifier 

Get Resource and Role Rates from P6 

This business flow is used to push Rates data from P6 to Unifier Company Workspace. The 
business flow can be initiated from Unifier or Gateway. After it is initiated from either of these 
applications, Gateway will have all the data from P6 and will send the data to Unifier Provider. 
Unifier Provider then creates/updates the Master Rate Sheet in Unifier Company Workspace. 

The following P6 parameters are enabled for this flow: 

 Include resource hierarchy 

 Include role hierarchy 

The following Unifier parameter is enabled for this flow: 

Delete data that no longer exists in the source application? (Default value = Yes) 

Synchronization: Resource and Role Rates from P6 

This synchronization is set: 

 To be out-of-the-box (OOB) to be initiated from Unifier. 

 To fetch the Resource and Role list from P6, along with the respective standard rate. 

If the Master Rate Sheet does not exist in Unifier, create one and populate the fields with the 
data that you received from Gateway (use this format for the sheet name: <Unifier project 
name><Rate Sheet Type>) 

If the Master Rate Sheet exists in Unifier, the fields values will be updated with the data from 
Gateway. 

Whether the Master Rate Sheet exists or not, you need to create a Master Rate Sheet, in Unifier 
Shell, for the first time. Once you create the Master Rate Sheet, the synchronization will keep 
updating it with latest data as received from Gateway. 
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Note: If a transaction fails because of connection issues with Gateway, 
or incorrect Gateway parameters in Unifier Admin Mode, it is recorded in 
the job history with an error message. 
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Unifier Reports 

The following sections provide details about the User Defined Report (UDRs) in Unifier. 

Also see the Internationalization and CSV Files section for language (Internationalization) 
details. 

In This Section 
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About User-Defined Reports (UDRs) 

A User-defined report (UDR) is a customizable report that can be run at the project, shell, 
program, and company level (user mode). The information that can be included in a UDR can 
include: 

 Any business process data element (that is, fields found on the business process form) 

 Business process workflow information 

 System data elements, including company, project, shell, and user information 

 Column headings from cost, funding, schedule sheets 

 Cost sheet and work package data elements 

 Shell P6 Summary 

 Data views in published status 

The data source for creating a report using the Shell P6 Summary data type are: P6 Summary 
and Spread. 

You can open the tables within the P6 Summary Sheets in Unifier for data views. 

You can define as many different reports as you need and save them for other users to access 
and run. 

User-defined reports are defined the same way for the project, shell, program, and company 
level. Only the query fields will vary from report to report. 
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You can run reports on cash flow curve values in either transaction or project currencies. The 
UDR will show the values in the chosen currency and it will display the exchange rate used for 
the conversion between the transaction and project currency. 

You can also run Snapshot reports in both currencies. All changes done in the UDR will be 
supported for Snapshot reports. 

Accessing User-Defined Reports (UDRs) 

User-defined reports (UDRs) are set up and run in User mode.  

You can run UDRs at: 

 Project-level 

 Shell-level 

 Program-level 

 Company-level 

When you are running a report based on a permission-aware Document Manager data source, 
Unifier allows you to see the report only if you have permission to see the data source, in case 
of:  

 Document Manager - Company 

 Document Manager - Project/Shell 

To access a project-level user-defined reports 

In User mode, open a project or shell. Navigate to Reports > User-Defined. The 
User-Defined Reports log opens. 

To access a shell-level user-defined reports 

In User mode, open a project or shell. Navigate to Reports > User-Defined. The 
User-Defined Reports log opens. 

To access a program-level user-defined reports 

In User mode, open a program. Navigate to Reports > User-Defined. The User-Defined 
Reports log opens. 

To access a company-level user-defined reports 

In User mode, open the company (User mode). Navigate to Reports > User-Defined. The 
User-Defined Reports log opens. 

The following describes the User-Defined Reports log elements, for the Company Workspace 
tab (Admin mode) > Templates > Project (Standard) > All > click a [project] to open > 
Reports > User-Defined Reports.  

User-Defined Reports log menu options: 
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File Enables you to perform the following actions: 

 New

 Copy

 Report

 Template

 Open

 Update Projects

 Projects

 All Projects

 History

 Import

Edit Enables you to edit or Delete a report. 

View Enables you to perform the following actions: 

 All

 Find

 Saved Results

 Audit Log

Help Enables you to access: 

 Unifier Help

 Unifier Library

 User Productivity Kit

 About Unifier

User-Defined Reports log toolbar options: 

New Enables you open the Create a new report (Create User-defined Report) 
window and set up the following fields: 

 Data Type

 Element

 Report Type

 Access Type

Copy Enables you to copy a: 

 Report

 Template

Open Enables you to open a record. 

Edit Enables you to edit a report. 
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Delete Enables you to delete a report. 

Find Enables you to find a report on the log. 

Saved 
Results

Enables you to see the saved results. 

Update 
Project
s

Enables you to access: 

 Projects

 All Projects

 History

Import Enables you to import a report. 

User-Defined Reports log columns: 

The columns provide the following details about each UDR. 

 Name

 Description

 Data Type

 Access Type

 Report Type

 Owner

 Creation Date

 Last Modified By

 Last Modified Date

 Scheduled

 Last Run Date

User-Defined Reports Log 

The following table details the User-Defined Reports log window: 

Note: You will need specific permissions to use the following functions. 

User-Defined Reports log window toolbar options

Create Enables you to select a source for your newly defined reports by 
providing the following options: 

Note: You need to have permission to create 
UDRs. 

 System Data Sources

 Permission Based Data Sources

 Copy From Templates
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Actions Enables you to perform the following functions on the selected report: 

 Transfer Ownership

 Delete

View Similar to the View function of a BP, it enables you to set the view of 
the User-Defined Reports log window by using the following options: 

 All Reports

 Owned by Me

 Create new view

 Manage Views

Refresh Enables you to refresh the information displayed on the log. 

Print Enables you to print the contents of the log. 

Find on page Enables you to find specific information on the log. 

User-Defined Reports log window columns

Name The name of the report. 

Description The description of the report, if available. 

Data Type The report data type. 

Access Type The report access type. 

Report Type The report format type. You can create and run user-defined reports 
of the following types: 

Tabular: This is the basic report format, arranging information 
vertically in columns. Tabular reports are a way to present related 
information for multiple records on the same page. 

Cross tab: Cross tab reports allow the display of data on two axes 
and enable users to run time-series reports defined by two data 
sources, for example, payments made per quarter per vendor. 

Summary: Summary reports can be run to display summary data. 
Project-level summary reports can also be used to customize the 
project summary page and include the information that is most useful 
for you. 

Alert: Project- or shell-level alert reports are used to set up and 
customize system alerts based on project- or shell-level triggers that 
you specify. For example, you have an alert let you know when your 
remaining budget is getting low. Alerts are set up and customized by 
users for their own use using alert reports. 
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Enable for 
Integration

The condition of the report related to integration. 

Owner The owner of the report. 

Last Run Date The date the report was run the last time. 

Creation Date The creation date for the report. 

Last Modified 
By

The person who modified the report the last time. 

Last Modified 
Date

The date the report was modified the last time. 

Schedule The schedule that is set for the report to run. 

User-Defined Reports log window right-hand pane

Saved Results
tab 

This tab provides the following information about the selected report, 
if available: 

 Run Date

 Schedule/Ad-hoc

 Run Buy

 Output For

User-Defined Report Types 

You can create and run user-defined reports of the following types: 

Tabular: This is the basic report format, arranging information vertically in columns. Tabular 
reports are a way to present related information for multiple records on the same page. 

Cross tab: Cross tab reports allow the display of data on two axes. Cross tab reports enable 
users to run time-series reports defined by two data sources, for example, payments made per 
quarter per vendor. 

Summary: Summary reports can be run to display summary data that can be used on 
project/shell, program and company Summary views. 

Alert: Project/Shell-level alert reports are used to set up and customize the generation of system 
alerts, based on a project/shell trigger that you specify. For example, you can have alerts let you 
know when your remaining budget is getting low. Alerts are set up and customized by users for 
their own use using alert reports. 
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User-Defined Report Data Types 

After choosing the report type (Tabular, Cross tab, Summary or Alert), you choose a data type. 
This determines the type of data that will be displayed on the report. 

Data Type 
Project 
UDR 

Shell 
UDR 

Progra
m UDR 

Compan
y UDR 

UDR 
Templa
te 

Use for Maintenance 
Management Only 

Accounts Sheet x 

Active Task 
Information 

x x x x 

Asset Summary 
Sheet 

x 

Audit x x 

Commitment 
Summary 

x x x 

Company Cash 
Flow 

x 

Company Cost x 

Company User 
Information 

x 

Cost Sheet - CBS x x x x 

Cost Transactions 
-CBS 

x x x x 

Cost Transactions 
MC - CBS 

x x 

Data Views x x x x x 

Document 
Manager 

x x x x x 

Document 
Manager—Compa
ny 

x 

Equipment x x 

Funding x x x x 

Gates x x x x 

Inventory x x 

Inventory On-hand 
Detail 

x x 
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Item Master x x 

Job Plan x x 

Master PM Book x x 

Master PM Meter 
Schedule 

x x 

Master PM Time 
Schedule 

x x 

Material 
Transaction 

x x 

Partner User 
Information 

x 

PM Book x x 

PM Meter 
Schedule 

x x 

PM Time 
Schedule 

x x 

Program Cash 
flow 

x 

Program Cost x 

Program Schedule x 

Resource Booking x x 

Resource 
Manager—All 
Actuals 

x 

Resource 
Manager—Allocat
ed Roles 

x x x 

Resource 
Manager—Booke
d Resources 

x x x 

Resource 
Manager—Project 
Actuals 

x x x 

Resource 
Manager - 
Resources 
(Company) 

x 

Resource x 
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Manager—Roles 

Resource 
Manager—Sheets

x x x 

Service Center x x 

Service Request x x 

Schedule of 
Values 

x x x x x 

Shell or Project 
Cash Flow 

x x x x x 

Shell or Project 
Cost 

x x x x 

Shell or Project 
Groups 

x x x x 

Shell or Project 
Information 

x x x 

Shell or Project 
Users 

x x x 

Workflow 
Information 

x x x x x 

Work Order x x 

Work Order Items x x 

Work Order Role x x 

(Asset class 
name) 

x 

(Business process 
name) 

x x x 

(Planning type 
name) 

x 

Running a User-Defined Report (Standard View) 

Running a user-defined report consists of the following elements: 

 Define query parameters if applicable 

 Review/choose projects or shells to include if applicable 

 Add runtime notes if applicable 

 Choose the report format (HTML, CSV, Excel, PDF, XML) 

 Run the report 
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The following describes how to run project, shell, program and company-level user-defined 
reports. 

Note: User-defined reports created with data view data types require the 
data view to be in "published" status. If the data view was changed to 
"draft" status, the report will not run, and you will see an alert. 

To run a user-defined report  

1) Open the shell, project, program, or company workspace. 

2) Navigate to the Reports module, click to expand, and click User-Defined to open the 
User-Defined Reports log. 

3) Select a report in the log. Double-click the report or click Gear menu > Run to open the 
report window. 

4) Select and enter values in the following blocks: 

 Query and Format

Depending on the report, this block enables you to select: 

Report Format

Record count for UDR

Time Zone

Report Query Parameters

 Report Location

Enables you to select where to save the report: 

Save results in Unifier

Document Manager

 Workspaces

 Notes

The following table contains details about the fields mentioned above. 

5) Click Run Report to generate the user-defined report. 

When the report is generated, you will be prompted to open or save the file. Click Open to 
view the file. PDF files will open in Acrobat Reader, from which you can save the file to your 
local drive by clicking File > Save. XML files will open in a pop-up browser window. Or click 
Save to save the file to your local drive. 
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Query and Format 

Report 
Format

Choose the format in which the report should appear: HTML, PDF, 
CSV, Excel, or XML. 

HTML Displays the report in the standard format in a browser window. 
You may print a copy of the report from the browser window. (Click the 
File menu and select Print or Print Preview.) 

CSV Formats the report in an exportable CSV format, usually in 
Microsoft Excel or another software application you have set up for this 
format. You will be prompted to save the file or open it. 

Excel Displays the report in Microsoft Excel format in the browser 
window. You can save an Excel formatted copy of the report or print 
from the window. (Click the File menu and select Save As or Print.) 

PDF Opens Adobe Acrobat Reader and displays the report in PDF 
format. You can save a copy of the report and/or print it from the PDF 
window. (Click the File menu and select Save or Print.) 

XML Generates the output in XML format. Before the results are 
generated, a confirmation window will open, giving you the option to 
save the XML file to your local machine (click Save), or display the 
results in a pop-up browser window (click Open). 

Record count 
or UDR

This option is available for Tabular, Summary, and Cross Tab type 
reports. 

You have ability to set the number of records to be retrieved for the 
report. This number will be set equal to the maximum number set at 
the company level by default, by the company administrator. 

The maximum number will be divided into intervals so that you can 
select the appropriate number. Also, the numeric format for the count 
must match your preferences. 

See the following table, "Options Available for Record Count," table, 
for more information about Record count for UDR. 

Time Zone For information purposes, the Query tab displays the time zone that is 
used for date fields in the report. The default time zone for a report is 
set up when the report is designed. It can reflect your user time zone, 
as defined in your user preferences, or it can be fixed to a particular 
time zone, such as the project location or company headquarters. 
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Report Query 
Parameters

If the report has been set up to enter query parameters, you may enter 
query information, which will give report results based on records that 
match the parameters you entered, or you can run a report on all 
records by leaving the field blank. 

The query parameters as defined during creation and set up. For 
example, you can set up a report to list all leases that expire within 10 
days of today. You can also choose to accept the default query 
parameters, if any. 

For program-level and company-level UDRs you can see all projects 
and shells with a status of Active, On-Hold, or View-Only. You can 
specify which project or shell the report should be saved in. For 
shell-level reports only, you can choose to exclude Inactive shells in 
the report run. 

Depending on how the report was set up (specifically, if "Allow users to 
modify value(s) during execution" was enabled in the creation step), 
you may add or remove projects or shells as needed. 

For shell-level (cross-shell) UDRs, you can retrieve data across shells 
and sub-shells. You can select to exclude inactive shells in the report 
run, and the selection of shells is determined when the UDR is 
created. You cannot modify: 

 Current Shell and sub-shells 

 Current Shell only 

 Sub-shells only 

You cannot modify fields unless the fields are set as user-defined. If 
the "Allow user to modify User-defined list during execution" checkbox 
was selected when the UDR was created, the you can modify the list 
of User Defined shells at run time of the report by using the Add and 
Remove buttons. You can only add the shells in which you are a 
member user. 
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Report Location 

Save Report 
Location

If you want to save the report, choose the location it should be saved 
in: 

 Save results in Unifier

This checkbox becomes active if you select PDF or XML. Selecting 
this checkbox will save a copy of the PDF or XML report within 
Unifier and make it available for retrieval. 

 Document Manager

Saves the report in the Document Manager of Unifier. If you 
choose this option, you need to specify a name for the report (Save 
As) and which folder of the Document Manager it should be saved 
in (Location). 

Scheduled report runs can be saved and retrieved in PDF or XML 
formats and sent to the report owner or to the owner and other users 
and groups. These are chosen in the Schedule tab of the Edit Report 
window. 
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Workspace 

Workspace The Workspaces (in classic view, this was the shells tab) block are for 
shell-level, program-level, and company-level reports. In the 
Workspaces block you can add additional shells that the report can be 
generated from.  

When you run report, the Workspaces block displays "User Defined" if 
you have selected "User Defined" under the shells tab in the report 
definition. 

You can exclude Inactive Workspaces by checking the check box,  
"Exclude Inactive Workspaces," in the report definition. 

The projects or shells tabs appear for program-level and 
company-level UDRs and shows all projects and shells with a status of 
Active, On-Hold, or View-Only. 

You cannot modify the list unless the Workspaces block displays "User 
Defined." All of the shells selected in 

Edit report > Shells tab will be displayed in Workspaces overlay 
(Available Workspaces). 

If the checkbox "Allow user to modify User-defined list during 
execution" is checked, then can modify the list of workspaces by using 
the Add or Delete options. 

When you click Add, a new Workspaces Picker is displayed with both 
available and selected workspaces (Selected Workspaces section of 
the Workspaces page). All of the shells that are already added in the 
report definition are displayed in the Selected Workspaces. 

You can add additional Shells or remove the existing ones in the 
Workspaces Picker. 

The Type field has the default value of "All." The other options are all 
for active shell types. You can filter shells by type. 

The Find on Page option is available to quickly filter the available 
workspaces. 

The Select option will add all the newly added workspaces, as a part 
of filtered list, while reporting. 

The Cancel option will cancel the changes and closes the window. 

When in the report definition, under shells tab, any of the following 
options are selected, then the Workspaces block displays an empty list 
(similar to the classic view), and the report will be run for all 
workspaces(shells and sub workspaces (sub-shells)), based on the 
selection: 

 Current Shell and Sub-Shells 

 Current Shell only 

 Sub-Shells only 
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Notes 

Notes Enables you to enter report notes that will be included only on the 
current report results (to be generated) and will not be saved or 
generated in any subsequent report results. To enter notes, the data 
element runtime notes must be present in the report layout (Gear 
menu > Edit Report, Layout tab). 

Options Available for Record Count

Max Limit at 
Company

Options available at Report level

100,000 1,000 

10,000 

25,000 

50,000 

75,000 

100,000 

250,000 1,000 

50,000 

100,000 

150,000 

200,000 

250,000 

500,000 1,000 

100,000 

150,000 

200,000 

250,000 

500,000 
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750,000 1,000 

100,000 

150,000 

250,000 

500,000 

750,000 

1,000,000 1,000 

100,000 

250,000 

500,000 

750,000 

1,000,000 

Retrieve scheduled report results 

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined 
Reports log. 

Select a report from the log. The Saved Results tab opens in the right-hand pane.  

1) Double click the saved result or click Gear menu > Download to view. 

You will be prompted to open or save the results file. 

2) Select Open to view the file. PDF files will open in Acrobat Reader, from which you can save 
the file to your local drive by clicking File > Save. XML files will open in a pop-up browser 
window. Or click Save to save the file to your local drive. 

To delete saved report results 

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined 
Reports log. 

2) Select a report from the log. The Saved Results tab opens in the right pane.  

3) Click Gear menu > Delete. Click Yes to confirm. 

Query Parameters (Query tab) 

The Query tab allows the entry of query parameters as defined during creation and setup. If the 
report has been set up to enter query parameters, you may enter query information, which will 
give report results based on records that match the parameters you entered, or you can run a 
report on all records by leaving the field blank. 

User-Defined Report (UDR) and Query-Based Tab 

Users will be able to use the Summary Elements, from any of the QBTs, in any of the UDRs that 
the user wants to use if the UDR is based on the same business process record.  
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User-Defined Report Formats 

You can choose the format of user-defined report results. The report format options are available 
at the bottom of the User-defined Report window at runtime. 

User-defined Report window, Report Format section

The report format options are: 

 HTML: Displays the report in the standard format in a browser window. You may print a copy 
of the report from the browser window. (Click the File menu and select Print or Print 
Preview.) 

 CSV: Formats the report in an exportable CSV format, usually in Microsoft Excel or another 
software application you have set up for this format. You will be prompted to save the file or 
open it. 

 Excel: The report displays in Microsoft Excel format in the browser window. You can save an 
Excel formatted copy of the report or print from the window. (Click the File menu and select 
Save As or Print.) 

 PDF: Opens Adobe Acrobat Reader and displays the report in PDF format. You can save a 
copy of the report and/or print it from the PDF window. (Click the File menu and select Save
or Print.) 

 XML: Generates the output in XML format. Before the results are generated, a confirmation 
window will open, giving you the option to save the XML file to your local machine (click 
Save), or display the results in a pop-up browser window (click Open). 

 Save results in Primavera Unifier: This checkbox becomes active if PDF or XML is 
selected. Selecting this checkbox will save a copy of the PDF or XML report within Unifier 
and make it available for retrieval. 

Notes: 

Scheduled report runs can be saved and retrieved in PDF or XML 
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formats and sent to the report owner or to the owner and other users and 
groups. These are chosen in the Schedule tab of the Edit Report 
window. 

The DE of type Rich Text DE is not available to be added to the 
User-Defined Reports (Reports > User Defined).  

Save and Retrieve Scheduled Report Results 

Report owners can schedule user-defined reports to run automatically and save the results 
within Unifier as PDF or XML files. If you have run permission for a report, you can view or print 
any saved results. Report owners can delete saved results from a scheduled report run. 

You can save report results and query parameters on reports that you run manually (ad hoc). 
This option is available only when the report is being generated in PDF or XML format. This is 
available at runtime for project-level, shell-level, program-level and company-level user defined 
reports. 

Note: The default time zone for a report is set up when the report is 
designed. It can reflect the time zone of the person running the report, as 
defined in user preferences, or it can be fixed to a particular time zone, 
such as the project location or company headquarters. If the "user’s time 
zone" option was selected in the set up of this report, the time zone 
reflected on the scheduled report results will that of the report owner. 

To save report results 

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined 
Reports log. 

2) Select a report from the log and click Open. The User-defined Report window opens. The 
window displays results that have been saved from manual (ad hoc) report runs as well as 
scheduled report runs. 

3) In the Report Format portion at the bottom of the window, choose PDF or XML. 

4) Select the Save Results in Primavera Unifier checkbox. This saves a copy of the report 
results within Unifier. 

5) Click Run to run the report. This may take a few moments. 

6) When the report is generated, you will be prompted to open or save the file. Click Open to 
view the file. PDF files will open in Acrobat Reader, from which you can save the file to your 
local drive by clicking File > Save. XML files will open in a pop-up browser window. Or click 
Save to save the file to your local drive. 
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To retrieve saved report results 

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined 
Reports log. 

2) Select a report from the log and click the Saved Results button. The Saved Results window 
opens. 

3) Select a saved result and click Open. 

4) You will be prompted to open or save the results file. Click Open to view the file. PDF files 
will open in Acrobat Reader, from which you can save the file to your local drive by clicking 
File > Save. XML files will open in a pop-up browser window. Or click Save to save the file to 
your local drive. 

Retrieve saved UDR results 

To delete saved report results 

1) Navigate to the project-level, shell-level, program-level, or company-level User-Defined 
Reports log. 

2) Select a report from the log and click the Saved Results button. The Saved Results window 
opens. 

3) Select a saved result and click Delete. Click Yes to confirm. 

Print Report Results 

After running a report, you can print a copy. Depending on the report format you chose, the 
report results will be displayed in a browser window (HTML, XML), Adobe Acrobat Reader 
(PDF), Excel (Excel, CSV), or other software application displaying CSV format. The printing 
functionality will depend on the format of the report. 

To print report results 

1) Run a user-defined report. 
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2) For most formats, you can click the File menu and choose Print. For HTML and XML, you 
may need to right-click in the browser pop-up window and choose Print. Additional printing 
functionality may be available depending upon the report format. 

Transferring Reports Between Environments 

Multiple user-defined reports (UDRs) can be transferred between Unifier environments. 

1) Go to Company Workspace > Admin mode > Configuration Package Management > 
Component List. 

2) Click Create. 

3) Go to Company Workspace > User Defined Reports. 

4) Select your reports. 

5) Enter a value in the Name field (top left). 

6) (Optional) Click Error Check to see if there are any dependencies. 

7) Click Save. 

Note: You can use the Save As option if you want to copy the 
component list. 

8) Go to Company Workspace > Admin mode > Configuration Package Management > 
Configuration Packages (to create a configuration package). 

9) Click Create. 

10) Enter values in the Package Name, File name (zip file name), and Components Lists. 

11) Select the component list related to your selected report. 

12) In the New Configuration Package window click Next. The window displays a preview of 
your reports. 

13) Click Next. In case of errors, you will see messages, if no errors are detected, then respond 
to the following: 

 Do you want to publish this package for production? 

 Download package after creation. 

14) Click Create to create the configuration package. 

15) Import the configuration package into the destination environment to transfer the reports. 

Working with Custom Reports (Standard View) 

If your company has custom report in a Program, Project, or Shell developed through Oracle 
Business Intelligence Publisher (BI Publisher), the custom reports will be available under the 
Custom node (User mode > Reports > Custom > [Report Name]).  

Note: You must have permission to access custom reports in User 
mode. 

To run a custom report in a Program, Project, or Shell: 

1) Open the Program, Project, or Shell. 
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2) Switch to User mode. 

3) In the Navigator, click Reports > Custom > [Report Name]. The Reports log shows the list 
of available custom reports, if you have permission to access. 

4) The Report Settings Page will open in the right-hand pane. 

5) In the Template and Format section, select an output format. 

6) In the lower-right corner of the Report Page, click Run Report to generate the report in the 
selected format. 

Note: The print output is based on your permissions to certain data in 
Unifier. 

Report Settings Page 

When you select the Report Name node, under the Custom node in the left-hand navigator, the 
Report Settings Page will open in the right-hand pane. 

The following explains the main elements of the Report Settings Page: 

 Name

The Report name appears in the upper-left corner of the page. 

 Template and Format

The Template field is a drop-down list that displays the default template that was used at the 
time of designing the report in the BI Publisher server. If multiple templates are available for 
the External Report, then they will be listed in this drop-down list. 

The Format field is a drop-down list that displays the default format (set based on the default 
template) that was used at the time of designing the report in the BI Publisher server. If 
multiple formats are available for the selected template, then they will be listed in this 
drop-down list. 

Example 

Available Template: Contracts 

Available Formats: PDF, RTF 

 Search Parameters

This section contains all the parameters that are designed for the External Report in the BI 
Publisher server. The BI Publisher supports the following parameter data types: 

 String 

 Integer 

 Boolean 

 Date 

 Float 

Acceptable values (which include wildcard characters) for these parameters depend on the 
data model used for the report definition. 

Except for the Date parameter, the Reports Settings window displays a text field for the other 
parameters. 

 Additional Parameters

Displays additional parameters as defined by the report.  
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 Run Report

When you click Run Report, the system generates the report. When you run an External 
Report in the User mode, Unifier accesses the BI Publisher server and the External Report 
output will be based on the latest design of the report in the BI Publisher server. Unifier does 
not store any data related to the External Report content such as model, format, layout, and 
so forth. 

 Reset

When you modify the Template, Format, or Parameters fields, a Reset button will appear in 
the lower-right corner of the Report Page. Clicking Reset will clear out all the entries made 
by the user and will reset the fields back to the template default.  

Scheduling External Reports 

For steps involved in scheduling reports in BI Publisher server, refer to the Oracle Business 
Intelligence Publisher User's Guide. 

Custom node 

The Custom node, under the Reports node in the left-hand navigator, includes both the Internal 
Reports and the External Reports. 

When you select and open an Internal Report, the Internal Report log window opens and 
contains the following columns: 

 Name

Displays the name of the Internal Report that has been created in Unifier. 

 ID

Displays the system-generated ID, for example, uuu_ext_54 for external report and uuu_54 
for internal report. 

When you select and open an External Report, the External Report log window opens and 
contains the following columns: 

 Report Name

Displays the name of the External Report that has been created in the BI Publisher server. 

 Default Template

Displays the default template name (for the Default Format) of the External Report that has 
been set in the BI Publisher server. 

 Default Format

Displays the default format of the External Report that has been created in the BI Publisher 
server. 

Running an External Report 

When you run an External Report in the User mode, Unifier accesses the BI Publisher server 
and the External Report output will be based on the latest design of the report in the BI Publisher 
server. Unifier does not store any data related to the External Report content such as model, 
format, layout, and so forth.  
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When you open an External Report, the Report Settings window opens, which contains fields 
related to the External Report parameters (listed in the Parameters section of the window), and 
fields related to the template and format for the External Report (Available Templates and 
Available Formats). The User can set the External Report attributes in the Reports Settings 
window. 

Permission-Based User-Defined Reports (UDRs) 

When you are creating User-Defined Reports (at Project/Shell, Program, and Company levels), 
you have the option to create UDR with System Data Sources or UDR with Permission Based 
Data Sources.  

Note: To be able to create the UDRs, you must have the Permissions 
Create All, Create Permission Based, and Full Access permissions. 

1) Go to Project/Shell, Program, or Company (User mode). 

2) Click the Reports node to expand. 

3) Click User-Defined sub-node. 

4) Click Create and select one of the following:  

a) System Data Sources

b) Permission Based Data Sources

If you select the System Data Sources option, you can use the Create a new report window to 
create a UDR based on the following fields: 

 Data Type 

 Report Type 

 Access Type (read-only) 

If you select the Permission Based Data Sources option, the following data sources are 
available to create permission-aware UDRs: 

 Business Process (BP) 

 Document Manager  

In the User-Defined Reports log, the Copy from Templates option (based on the report that is 
selected) will create a copy of the report based on the existing functionality. 

The above applies to when you have the Permissions Create Permission Based permission. 

When only have the Create for Permission Based Data Sources permission, you have the 
ability to create UDRs based on the permission aware data. 

When creating a new UDR by way of copying an existing one, if you select a System Access 
Type report, the system does not allow you to create a UDR that is based on System Data 
Sources and displays an alert. 

The permission for permission-aware data sources for a report that is packaged will be 
transferred from one environment to another. 

Review the following for more information
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When you are running report based on system-defined data sources, if your report is based on 
system-defined data sources, then the report will contain the system-defined data irrespective of 
your permissions. The same result will be applicable to the Schedule Reports. 

When you are running report based on permission aware BP data sources, and the permission 
aware reports are created based on BP data sources, then: 

 The data in the report will be based on the permissions of the user who is running the report. 
That is to say, the data sources only returns data that the user has permissions to see 
through the user interface. This is based on records returned, and the user will be able to 
see data that is in hidden blocks or hidden tabs. 

 If you are running a permission based report, and you do not have access to the data for the 
BP data source, then the report output will be blank. 

 In case of Scheduled Reports, the data returned will be based on the permissions of the user 
who is creating the report. 

 The permission restriction is applicable to the first level of data source, only. 

Example 

User One and User Two are Unifier users. 

User One has permission to access the Meeting Minutes BP, but User Two does not have 
permission to access the Meeting Minutes BP. 

The Meeting Minutes BP log has a column that refers to an Action Items BP. 

User One does not have permission to access the Action Items BP. 

When User One creates and runs a report on the Meeting Minutes BP, User One will be able 
to see the data related to Meeting Minutes BP as well as the column data which references 
the Action Items BP. 

When User Two creates and runs a report on the Meeting Minutes BP, User Two will see a 
blank report. 

 For a Company-level UDR, if the access permission to data goes across the projects, then 
you will be able to view the data for BPs based on permission levels present for those BPs 
across the projects. 

When user is running report based on permission aware Document Manager data source  

 When running such a report, data will be seen based on user who is running report ie  data 
sources only return data that the user has permissions to see. The folder and document level 
permissions when present  will also be taken into consideration 

Transfer Ownership for UDRs 

The administrator can define who has access to the UDR.  

At the Company Level as well as Project level, you can use the Transfer Ownership option (at 
the log level) to change the owner of the UDR. This option will be available to change owner for 
multiple reports at a given time. 

1) Go to Company Workspace. 

2) Click Reports to expand. 

3) Click User-Defined to open the User-Defined Reports log. 

4) Select the reports the you want the owners changed. 
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5) Click Actions > Transfer Ownership to open the User/Group Picker window.  

6) Select the new owner for the reports. 

You can only select one user in the User/Group Picker window. 

The list of users that you see contains the users who have access to the Project/Shell. 

The user must have Full access permissions. 

You can change owner o a report when editing by way of the Report Owner field in General tab 
in runtime. 

Once the owner for the report is changed, the Permission tab in the UDR displays the new 
changed owner with all permissions for that report. For example, if the ownership for report R1 
was changed from A-user to B-user, then the Permission tab display B-user, only (with full 
owner permission), and A-user will not be seen in the Permission tab. 

Working with Audit Reports (Standard View) 

If your company has custom report in a Program, Project, or Shell, it will be available under the 
System node (User mode > Reports > System > Audit).  

Note: You must have permission to access custom reports in User 
mode. 

To run a custom report in a Program, Project, or Shell: 

1) Open the Program, Project, or Shell. 

2) Switch to User mode. 

3) In the Navigator, click Reports > System > Audit.  

4) The Audit Report Page will open in the right-hand pane. 

5) Define query parameters if applicable. 

6) In the lower-right corner of the Report Page, click Run Report to generate the report in PDF 
format. 

Audit Report Page 

When you select the Audit node, under the System node in the left-hand navigator, the Audit 
Report Page will open in the right-hand pane. 

The following explains the main elements of the Audit Report Page: 

 Audit Summary Report Query

This section contains all the query parameters that are designed for the Audit Report. You may 
enter query information, which will give report results based on records that match the 
parameters you entered, or you can run a report on all records by leaving the fields blank. The 
following query parameters will be visible:  

 Description contains 

 Event Name containsr 

 From (Company) 
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 From (User) 

 From 

 To 

 Sort by 

 Order 

 Run Report

When you click Run Report, the system generates the report in PDF format.  

 Reset

When you modify the query parameters, a Reset button will appear in the lower-right corner 
of the Report Page. Clicking Reset will clear out all the entries made by the user and will 
reset the fields back to the template default.  
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Unifier Mobile Application for iOS or Android 

If your company employees are often out of the office, Unifier can keep the workflow moving by 
using the Oracle Primavera Unifier Mobile Application. The Unifier Mobile App is built specifically 
for installation and use on mobile devices that use iOS or Android operating system. 

By using the Unifier Mobile App on you can: 

 Act on the assigned tasks 

 View the various tasks 

 Create new business process records 

 Work offline 

To get the Unifier Mobile App, you have the following options:  

 Download it from App Store or Play Store, or 

 Launch Unifier, click User login name ( ), click Get Unifier Mobile App, and follow 
the prompts. 

After download, you can scan the QR code to set up Unifier Server URL and user name on your 
Oracle Primavera Unifier Mobile Application. 

Note: If your organization is using a Content Security Service or Mobile 
Device Management solution and requires that users do not download 
from the Apple Store or Play Store directly, submit a Service Request in 
My Oracle Support to request unsigned versions of the Oracle Primavera 
Unifier Mobile Application for Android or iOS. 
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Business Processes 

The following Business Processes (BPs) can be accessed through the mobile app: 

 BPs used by field employees to record, or gather, data. 

 Cost Type BPs used by executives, or approvers. 

 BPs that require action. 

In order for a Business Process (BP) to be accessed through the Unifier Mobile app for iOS, the 
following conditions must be present:  
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 The BP must be enabled for mobile application (Enable for Mobile Application) in the 
configuration window (General tab), in the business process configuration. 

 The forms, seen in the mobile app, are the forms designed in uDesigner. 

 The Payment Application and Summary Payment Application Cost BPs can be enabled for 
mobile app, but you cannot create Line Items in those BPs. 

 The Request for Bid (RFB), Resource, and Project/Shell Creation BPs are not supported in, 
and cannot be configured for, the mobile app. 

Notes:  

 The mobile app does not rely on the checkbox option of “Enable for 
Mobile/Handheld” that was set in uDesigner. 

 The setting of this option will be exported to the created Configuration 
Package (Company Workspace, Shell template, and so forth). 

 You cannot view data related to Business Processes, and assigned 
tasks, without proper Unifier Mobile App configuration. Before you 
download the Unifier Mobile App for iOS, contact your Company 
Administrator and check if the required setup has been done, or not. 

Data Type and Input Type 

The following data and input types are supported in the mobile app 

Data Type Input Type 

Checkbox Integer 

Currency Float 

Multi Select Input String 

Multi Test Lines String 

Picker String, Date, Integer 

Pull Down Menu String, Integer 

Radio buttons String, Integer 

Text Box String 

Date picker String 

Pickers 

The following pickers are supported in both the iOS and Android Unifier mobile apps:  

Picker Single/Multi select 

BP Picker Single select 
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Picker Single/Multi select 

User Data Picker Single select 

CBS Picker Single select 

Data Picker Single select 

BP Line Item Picker Single select 

Configurable Manager Picker (CMx Picker) Single select 

Generic Cost Picker (CM0 Picker) Single select 

User Picker Single select 

Image Picker Single select 

Modules and Nodes 

The following modules and nodes are supported in the mobile app: 

Unifier Module Node in the app 

Tasks 

The tasks that are assigned to the 
signed-in use. 

My Tasks 

Shells 

Standard Projects and Shells that the user 
has access to. 

Projects  

User Identity 

If Unifier has been configured to sign in users using single sign-on (SSO), then the Sign In 
window will not appear on your device screen. In addition:  

 Unifier does not capture the user’s username and password. 

 The user’s first name, last name, and email address are all stored in Unifier database, but 
they are not shared with any other applications, including third-party applications. 

If Unifier has been configured to sign in users using basic authentication, then the Sign In 
window will appear on your device screen. In addition: 

 Unifier captures the user’s username, password, first name, last name, and email address. 

 The user’s username, password, first name, last name, and email address are stored in a 
shared object that uses encrypted format, and they are not shared with any other 
applications, including third-party applications. 
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